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DAQ Getting Started Guide
This guide describes how to install and configure the NI-DAQmx 8.x driver 
software, your NI data acquisition (DAQ) device, and confirm the device is 
operating properly. For instructions on configuring Traditional NI-DAQ 
(Legacy), refer to the Traditional NI-DAQ (Legacy) Readme, accessible 
from Start»Programs»National Instruments»NI-DAQ after you have 
installed the software.

NI-DAQ Software
National Instruments measurement devices are packaged with NI-DAQ 
driver software, an extensive library of VIs and ANSI C functions 
you can call from your application software, such as LabVIEW or 
LabWindows™/CVI™, to program your NI measurement devices, such as 
the M Series multifunction I/O (MIO) DAQ devices, signal conditioning 
modules, and switch modules. Driver software has an application 
programming interface (API ), which is a library of VIs, functions, classes, 
attributes, and properties for creating applications for your device.

NI-DAQ 7.x and later includes two NI-DAQ drivers, each with its own 
APIs, hardware configuration, and software configuration. NI-DAQmx is 
the latest NI-DAQ driver with the following advantages over Traditional 
NI-DAQ (Legacy).

• DAQ Assistant—a graphical way to configure virtual channels and 
measurement tasks for your device, and to generate NI-DAQmx code 
based on your virtual channels and tasks, for use in LabVIEW, 
LabWindows/CVI, Measurement Studio, and VI Logger

• Increased performance, including faster single-point analog I/O and 
multithreading

• NI-DAQmx simulation for most supported devices for testing and 
modifying applications without plugging in hardware; refer to the 
NI-DAQ Readme for NI-DAQmx-supported devices that do not have 
NI-DAQmx simulated device capability

• Simpler, more intuitive APIs for creating DAQ applications using 
fewer functions and VIs than earlier versions of NI-DAQ

Traditional NI-DAQ (Legacy) is an older driver with outdated APIs for 
developing data acquisition, instrumentation, and control applications for 
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older National Instruments DAQ devices. You should use Traditional 
NI-DAQ (Legacy) only in certain circumstances. Refer to the NI-DAQ 
Readme for more information about when to use Traditional NI-DAQ 
(Legacy), including a complete list of supported devices, operating 
systems, and application software and language versions. 

Step 1. Install Application Software
Install your NI application software. To use NI-DAQmx, install 
LabVIEW 7.x or later, LabWindows/CVI 7.x or later, Measurement 
Studio 7.x or later, VI Logger 2.x, or the LabVIEW Real-Time Module 7.1 
or later.

If you have an existing application written with an earlier version of your 
application software or NI-DAQ, make a backup copy of the application. 
You then can upgrade your software and modify the application.

Step 2. Install NI-DAQ 8.x 
Install your driver software before installing new hardware devices so 
Windows can detect your device. Do not install NI-DAQ 8.x if your 
existing applications include unsupported components, which are listed in 
the NI-DAQ Readme.

1. Insert the CD. The NI-DAQ 8.x installer should open automatically. If 
not, select Start»Run. Enter x:\autorun.exe, where x is the letter 
of the CD drive. For troubleshooting instructions, refer to 
the Hardware Installation/Configuration Troubleshooter at 
ni.com/support/install.

2. Install the software. 

• Install copies the software and/or documentation files onto your 
hard drive. NI-DAQ software documentation is installed when you 
install the driver software. 

• View opens the device documentation so that you can find, view, 
and print documents without installing them. 

Caution NI-DAQ 7.x or later cannot exist on the same system with versions of NI-DAQ 
previous to version 7.0.

3. Install the support files. The NI-DAQ installer detects the NI software 
installed on the system and automatically selects the latest versions of 
the driver, application software, and language support files from the 
CD. Verify that the installer detected and selected the correct support 
files and version number.
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If you install NI-DAQ before installing NI application software 
version 7.x or later, you must run the NI-DAQ installer again to install 
the correct application software support.

4. Click Next at the prompts.

5. Click Finish.

6. When the NI-DAQ installer completes, a message opens asking if you 
want to exit, shut down, or restart.

• Exit to install more NI software or documentation. 

– Install online documentation for supported devices and 
accessories, including PDF and help files describing device 
terminals, specifications, features, and operation. Reinsert the 
NI-DAQ CD to reopen the installer screen. Select Install 
Device Documentation. 

– If you are using a MXI-3 link from a PC to control a PXI 
chassis, exit and install the MXI-3 software, available at 
ni.com/downloads, before using the DAQ device.

• Shut Down if you are ready to install your device.

• Restart if you are using a system running the LabVIEW 
Real-Time Module. Download NI-DAQ 8.x to the target using 
Measurement & Automation Explorer (MAX). Refer to the 
Measurement & Automation Explorer Remote Systems Help by 
selecting Help»Help Topics»Remote Systems.

Step 3. Unpack the Devices, Accessories, and Cables
Remove the device from the package and inspect the device for loose 
components or any sign of damage. Notify NI if the device appears 
damaged in any way. Do not install a damaged device.

For safety and compliance information, refer to the device documentation, 
available at ni.com/manuals or accessible from Start»Programs» 
National Instruments»NI-DAQ»Browse Device Documentation after 
you install it. 

The following symbols may be on your device.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this symbol is marked on 
the device, refer to the Read Me First: Safety and Radio-Frequency 
Interference document, shipped with the device, for precautions to take.

When this symbol is marked on a product, it denotes a warning advising 
you to take precautions to avoid electrical shock.

When this symbol is marked on a product, it denotes a component that may 
be hot. Touching this component may result in bodily injury.
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Step 4. Install the Devices, Accessories, and Cables
If you have more than one DAQ device to install, install them all now. 
If your system includes SCXI modules to connect to DAQ devices, first 
install the DAQ components.

Caution Follow proper ESD precautions to ensure you are grounded before installing the 
hardware. Refer to the specifications document for your device for important safety and 
compliance information. 

You can test NI-DAQmx applications without installing hardware by using 
an NI-DAQmx simulated device. Refer to the Measurement & Automation 
Explorer Help for NI-DAQmx by selecting Help»Help Topics» 
NI-DAQmx for instructions on creating NI-DAQmx simulated devices. 

PCI and PCI Express Devices
Complete the following steps to install a PCI or PCI Express device:

1. Power off and unplug the computer.

2. Remove the computer cover and/or the expansion slot cover.

3. Touch any metal part of the computer to discharge any static electricity.

4. Insert the device into the applicable PCI or PCI Express system slot. 
Gently rock the device into place. Do not force the device into place.

Figure 1.  Installing a PCI Device

Per the PCI standard, NI PCI DAQ devices with the Universal PCI 
connector are supported in PCI-compliant buses, including PCI-X. 
You cannot install PCI Express devices in PCI slots and vice versa. PCI 
Express devices support up-plugging into a PCI Express slot of higher 

1 PCI DAQ Device 2 PCI System Slot 3 PC with PCI Slot

3

1
2
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lane width. Some motherboards reserve the x16 slot for graphics use; 
refer to the computer manufacturer’s instructions for alternative 
graphics solutions if using the x16 slot for nongraphics devices. For 
guidelines on PCI Express, refer to ni.com/pciexpress.

5. Secure the device mounting bracket to the computer back panel rail.

6. Replace the computer cover, if applicable.

PCMCIA Devices
You can install the NI PCMCIA device in any available Type II PC Card 
slot. Complete the following steps.

1. Remove the PCMCIA slot cover on your computer, if any.

2. Insert the PCMCIA bus connector of the PCMCIA device in the 
slot until the connector is firmly seated.

Figure 2.  Installing a PCMCIA Device in a Laptop PC

3. Attach the I/O cable. Be careful not to put strain on the I/O cable when 
inserting or removing the cable connector. Always grasp the cable by 
the connector you are inserting or removing. Never pull directly on the 
I/O cable to unplug it from the PCMCIA device.

1 Computer with PCMCIA Slot
2 PCMCIA Socket
3 PCMCIA Device

4 Shielded I/O Cable
5 Accessory
6 Signal Lines

®

®

DAQCard
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PXI Devices
Complete the following steps to install the PXI module.

1. Power off and unplug the PXI chassis.

Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document 
packaged with your PXI chassis or device before removing equipment covers or 
connecting or disconnecting any signal wires.

2. Remove the filler panel of an unused PXI slot. For information on 
slot requirements, refer to the device documentation as described 
in Step 2. Install NI-DAQ 8.x.

3. Touch any metal part of the chassis to discharge static electricity.

4. Ensure that the PXI module injector/ejector handle is not latched and 
swings freely.

5. Place the PXI module edges into the module guides at the top and 
bottom of the chassis.

6. Slide the device into the PXI slot to the rear of the chassis.

7. When you begin to feel resistance, pull up on the injector/ejector 
handle to fully insert the device.

8. Secure the device front panel to the chassis front panel mounting rail 
using the front-panel mounting screws.

 

Figure 3.  Installing a PXI Device

1 PXI Chassis
2 PXI System Controller
3 PXI Module
4 Injector/Ejector Handle

5 Front-Panel Mounting Screws
6 Module Guides
7 Power Switch
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USB Devices
Complete these steps to install an NI device for USB:

1. Make power connections.

• If you are using the BP-1 battery pack, follow the installation 
instructions in your BP-1 installation guide.

• Some NI devices for USB require external power.

– If your device has an external power supply, verify that the 
voltage on the external power supply, if any, matches the 
voltage in your area (120 or 230 VAC) and the voltage 
required by your device. Connect one end of the power supply 
to an electrical outlet and the other end to your device.

– If your device has a power cord, connect one end of the power 
cord to the device and the other end to an electrical outlet.

2. Connect the cable from the computer USB port or from any other hub 
to any available USB port on the device. 

3. If you have a USB device with a power switch, power on the device. 
The computer should immediately detect your device.

Accessories
Install accessories and/or terminal blocks according to the instructions in 
their installation guides. For SCXI and SCC signal conditioning systems, 
continue with the instructions in this guide through Step 8. Install Signal 
Conditioning or Switch Devices.

Step 5. Power On Your Computer or PXI Chassis
Windows recognizes any newly installed device the first time the computer 
reboots after hardware is installed. On some Windows systems, the Found 
New Hardware wizard opens with a dialog box for every NI device 
installed. Install the software automatically (Recommended) is selected 
by default. Click Next or Yes to install the software for each device.

When the computer recognizes a USB device, the power LED on the device 
blinks or lights up. Refer to the device documentation for LED pattern 
descriptions. 

Step 6. Confirm That the Device Is Recognized
Complete the following steps:

1. Double-click the Measurement & Automation icon on the desktop to 
open MAX.
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2. Expand Devices and Interfaces then expand NI-DAQmx Devices. 
If you are using a remote RT target, expand Remote Systems, find and 
expand your target, and then expand Devices and Interfaces. For 
instructions about configuring Traditional NI-DAQ (Legacy), refer 
to the Traditional NI-DAQ (Legacy) Readme, accessible from 
Start»Programs»National Instruments»NI-DAQ after you have 
installed the software.

3. Check that your device appears under Devices and Interfaces. If your 
device does not appear, press <F5> to refresh the view in MAX. If the 
device is still not recognized, refer to ni.com/support/install.

4. Right-click the device and select Self-Test.
 

If you need help during the self-test, open Measurement & Automation 
Explorer Help for NI-DAQmx by selecting Help»Help Topics» 
NI-DAQmx. When the self-test finishes, a message indicates 

1 When a device is supported by both NI-DAQmx and Traditional NI-DAQ 
(Legacy) and both are installed, the same device is listed with a different name 
under My System»Devices and Interfaces. 

2 Only NI-DAQmx Devices are listed under Remote Systems»Devices and 
Interfaces. 

1

2



© National Instruments Corporation 9 DAQ Getting Started Guide

successful verification or if an error occurred. If an error occurs, refer 
to ni.com/support/install for troubleshooting information.

You can test NI-DAQmx applications without installing hardware 
using an NI-DAQmx simulated device. Refer to the Measurement & 
Automation Explorer Help for NI-DAQmx by selecting Help» 
Help Topics»NI-DAQmx for instructions about creating NI-DAQmx 
simulated devices and importing NI-DAQmx simulated device 
configurations to physical devices. 

Step 7. Configure the Device Settings
Configure each device you install:

1. Right-click the device name and select Properties. Be sure to click the 
device name under the folder for the system (My System or Remote 
Systems) and NI-DAQ API in which you want to control the device. 

2. Configure the device properties. To use a device in both NI-DAQmx 
and Traditional NI-DAQ (Legacy), you must configure it in each.

• If you are using an accessory, add the accessory information.

• For IEEE 1451.4 transducer electronic data sheet (TEDS) sensors 
and accessories, configure the device and add the accessory as 
previously described. Click Scan for TEDS. To configure TEDS 
sensors cabled directly to a device, in MAX, right-click the device 
under Devices and Interfaces and select Configure TEDS.

3. Click OK to accept the changes.

Step 8. Install Signal Conditioning or Switch Devices
If your system includes SCXI signal conditioning modules, Signal 
Conditioning Components (SCC) such as SC carriers and SCC modules, 
terminal blocks, or switch modules, refer to the getting started guide for the 
product to install and configure the signal conditioning or switch hardware.

The rest of this guide applies to DAQ and PXI integrated signal 
conditioning devices.
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Step 9. Attach Sensors and Signal Lines
Attach sensors and signal lines to the terminal block or accessory terminals. 

You can view and print a connection diagram for NI-DAQmx tasks and 
virtual channels in your system through the DAQ Assistant. Select the task 
or virtual channel and click the Connection Diagram tab. Select each 
virtual channel in the task to view the terminal names and numbers for 
connections from sensor to connector block. 

Pin assignments also are accessible from the device documents on the 
Device Document Browser, accessible from Start»Programs» 
National Instruments»NI-DAQ»Browse Device Documentation after 
you install it, and from Device Terminals in the Measurement & 
Automation Explorer Help for NI-DAQmx.

For information about sensors, refer to ni.com/sensors or Sensors in the 
NI-DAQmx Help, which you can access from Start»Programs»National 
Instruments»NI-DAQ»NI-DAQmx Help. For information about IEEE 
1451.4 TEDS smart sensors, refer to ni.com/zone. 

Switch specifications include a topology of the device.

Step 10. Run Test Panels
Many devices have a test panel for testing specific device functionality, 
such as the ability to acquire and generate signals. 

1. In MAX, expand Devices and Interfaces»NI-DAQmx Devices. 
If you are using a remote RT target, expand Remote Systems, find and 
expand your target, then expand Devices and Interfaces.

2. Right-click the device to test. 

3. Select Test Panels to open a test panel for the selected device, shown 
in the following example.
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4. Click the tabs to test different functions of the device. Click Help 
for instructions about operating the test panels.

5. The test panel displays a message indicating whether an error 
occurred. If so, refer to the NI-DAQmx Help or ni.com/support 
for troubleshooting information. 

6. Click Close to exit the test panel.

If you installed more than one DAQ device, repeat Step 7. Configure the 
Device Settings through Step 10. Run Test Panels for each device. 

Step 11. Configure Channels and Tasks
This step applies only if you are programming your device using 
NI-DAQmx or NI application software. 

A task, an important concept for NI-DAQmx, is one or more virtual 
channels with timing, triggering, and other properties. Conceptually, a task 
represents a measurement or generation to perform. You can set up and 
save configuration information in a task and use the task in an application.

In NI-DAQmx, you can configure virtual channels as part of a task or 
separate from a task. Virtual channels created inside a task are local virtual 
channels. Virtual channels defined outside a task are global virtual 
channels. You can create global virtual channels in MAX or in your 
application software and then save them in MAX. You can use global 
virtual channels in any application or add them to a number of different 
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tasks. If you modify a global virtual channel, the change affects all tasks in 
which you reference that global virtual channel. 

Configure a Task in NI-DAQmx
When using NI-DAQmx, configure tasks with the DAQ Assistant. You 
must have version 7.0 or later of an NI application software package to 
create tasks and virtual channels with the DAQ Assistant.

• In MAX, right-click Data Neighborhood and select Create New. 
In the Create New window, select NI-DAQmx Task and click Next. 
If you are using a remote RT target, you must first expand Remote 
Systems, then find and expand your target to see Data Neighborhood.

• You also can open the DAQ Assistant directly within NI application 
software:

– In LabVIEW, place on the block diagram the DAQ Assistant 
Express VI from the Express Input palette, as described in Getting 
Started with LabVIEW.

You also can open the DAQ Assistant by right-clicking the 
DAQmx Task Name control from the DAQmx Name Controls 
palette and selecting New Task (DAQ Assistant). Taking an 
NI-DAQmx Measurement in LabVIEW has step-by-step 
instructions for creating a task from the DAQmx Task Name 
control and generating code based on the task. In LabVIEW, 
select Help»Taking an NI-DAQmx Measurement.

– In LabWindows/CVI:

1. Select Tools»Create/Edit DAQmx Tasks. The Create/Edit 
DAQmx Tasks dialog box opens. 

2. Select Create New Task In MAX or Create New Task In 
Project and click OK.

– In Measurement Studio:

1. Open Visual Studio .NET and the project in which you want 
to create a DAQmx task class.

2. Select Project»Add New Item. The Add New Item dialog 
box opens. 

3. In the Categories pane, select Measurement Studio» 
Assistants.

4. In the Templates pane, select DAQmx Task Class.

5. Specify a name for the DAQmx task file and click Open. 

6. Specify whether to create a new task or a project copy of a 
global task you create in MAX and click Finish.

The DAQ Assistant prompts you to create a new task by selecting an I/O 
type, such as analog input, the measurement or generation to perform, the 
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sensor applicable for that measurement, and the physical channel(s) from 
which to create local virtual channels in the task. If you have already 
configured global virtual channels for the desired measurement type, click 
the Virtual tab to copy or add the global virtual channels to your task. Refer 
to the DAQ Assistant Help for instructions about creating tasks.

Configure Global Virtual Channels in NI-DAQmx
If you want to use virtual channels in multiple NI-DAQmx tasks or 
applications, configure global virtual channels with the DAQ Assistant. 
You can launch the DAQ Assistant to create a global virtual channel in 
MAX or in LabVIEW.

• To open the DAQ Assistant in MAX, right-click Data Neighborhood 
and select Create New. In the Create New window, select NI-DAQmx 
Global Virtual Channel and click Next. 

• To open the DAQ Assistant directly in LabVIEW to create a global 
virtual channel, drop a DAQmx Global Channel control on the front 
panel, right-click it, and select New DAQmx Channel.

The DAQ Assistant prompts you to create a new global virtual channel by 
selecting an I/O type, such as analog input, the measurement or generation 
to perform, the sensor applicable for that measurement, and the physical 
channel from which to create a global virtual channel. Refer to the 
DAQ Assistant Help for instructions about creating tasks and virtual 
channels and using them in an application.

In LabWindows/CVI and Measurement Studio, you cannot directly create 
a global virtual channel; you must create them in MAX as previously 
described.

You can add or copy a global virtual channel to a task from application 
software.

1. Launch the DAQ Assistant as described in Configure a Task in 
NI-DAQmx. 

2. Click the Add Channels button ( ). 

3. Select a global virtual channel to copy or add from the Virtual tab in 
the Add Channels to Task dialog box. 
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Step 12. Use Your Device in an Application

DAQ Assistant
Complete the following steps to use a measurement task in your application 
or generate code. Refer to the DAQ Assistant Help for more information.

LabVIEW
1. Open a blank VI in LabVIEW. 

2. Place the following constant on the block diagram: NI Measurement» 
DAQmx-Data Acquisition»DAQmx Task Name Constant.

3. Select the task from the pull-down menu. 

4. Right-click the VI and select Generate Code»Example. 

5. Run the program from the front panel.

LabWindows/CVI
Refer to ni.com/info and type rddq73 for step-by-step instructions for 
using a task in LabWindows/CVI.

Measurement Studio
Refer to ni.com/info and type rddqms for step-by-step instructions for 
using a task in Measurement Studio.

Examples
You can use examples to develop a new application or add example code 
to an existing application.

For additional examples, refer to ni.com/zone.

Software Application Example Location

LabVIEW or LabWindows/CVI Help»Find Examples

Measurement Studio-supported languages 

MFC C++  

Visual Basic .NET and C# examples*

MeasurementStudioVS2003\VCNET\ 
Examples\DAQmx

MeasurementStudioVS2003\DotNET\ 
Examples\DAQmx

ANSI C NI-DAQ\Examples\DAQmx ANSI C

* Do not require Measurement Studio
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To run examples without hardware installed, you can use an NI-DAQmx 
simulated device. In MAX, refer to the Measurement & Automation 
Explorer Help for NI-DAQmx by selecting Help»Help Topics» 
NI-DAQmx for information about creating NI-DAQmx simulated devices. 

VI Logger Lite
The NI-DAQmx CD includes VI Logger Lite, an easy-to-use 
configuration-based tool specifically designed for data logging 
applications. The application is available at Start»Programs» 
National Instruments»VI Logger. The VI Logger Help is available 
from MAX at Help»Help Topics»VI Logger.

More Information
After you install the device documentation, the browser and device 
documents are accessible from Start»Programs»National Instruments» 
NI-DAQ»Browse Device Documentation. The NI-DAQ software 
documents, such as the NI-DAQmx Help and DAQ Getting Started Guide, 
are accessible from Start»Programs»National Instruments»NI-DAQ» 
NI-DAQmx document title.

Troubleshooting
Use the following resources if you have problems installing your DAQ 
hardware and/or software:

• For troubleshooting instructions, refer to the Hardware Installation/ 
Configuration Troubleshooter at ni.com/support/install.

• Refer to ni.com/kb for documents about troubleshooting common 
installation and programming problems and for answering frequently 
asked questions about NI products.

• If you think you have damaged your device and need to return your 
National Instruments hardware for repair or device calibration, refer to 
ni.com/info and enter the info code rdsenn to learn how to begin 
the Return Merchandise Authorization (RMA) process.
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Worldwide Technical Support
For additional support, refer to ni.com/support or ni.com/zone. For 
further support information for signal conditioning products, refer to the 
Signal Conditioning Technical Support Information document packaged 
with your device.

National Instruments corporate headquarters is located at 11500 North 
Mopac Expressway, Austin, Texas, 78759-3504. National Instruments also 
has offices located around the world to help address your support needs.



Guide d’initiation DAQ
Ce guide décrit les étapes à suivre pour installer et configurer le driver 
NI-DAQmx 8.x, ainsi que votre périphérique d’acquisition de données 
(DAQ) NI, et confirmer que ce périphérique fonctionne correctement. Vous 
trouverez des instructions de configuration de NI-DAQ traditionnel (ancien 
driver) dans le fichier Readme de NI-DAQ traditionnel (ancien driver), 
accessible sous Démarrer»Programmes»National Instruments» 
NI-DAQ lorsque le logiciel aura été installé.

Driver NI-DAQ
Les périphériques de mesure National Instruments sont fournis avec le 
logiciel de drivers NI-DAQ, une grande bibliothèque de VIs et de fonctions 
C ANSI qui vous permettent d’appeler le logiciel de votre application, 
comme LabVIEW ou LabWindows™/CVI™ par exemple, pour 
programmer vos périphériques de mesure NI, tels que les modules d’E/S 
multifonctions (MIO) de la série M, les modules de conditionnement de 
signal et les modules Switch. Le logiciel de drivers comporte une API  
(Application Programming Interface), composée d’une bibliothèque de 
VIs, de fonctions, de classes, d’attributs et de propriétés qui servent à créer 
des applications pour votre périphérique.

NI-DAQ 7.x et versions ultérieures comprennent deux drivers NI-DAQ, 
chacun avec ses propres API et configurations matérielle et logicielle. 
NI-DAQmx est le tout dernier driver NI-DAQ ; il possède les avantages 
suivants par rapport à NI-DAQ traditionnel (ancien driver).

• Assistant DAQ, méthode graphique permettant de configurer des voies 
virtuelles et des tâches de mesure pour votre périphérique, et de 
générer du code NI-DAQmx basé sur vos voies virtuelles et vos tâches, 
en vue de l’utiliser avec LabVIEW, LabWindows/CVI, Measurement 
Studio et VI Logger.

• Des performances accrues, notamment des E/S analogiques point par 
point et un multithreading plus rapides.

• La simulation par NI-DAQmx de la plupart des périphériques 
supportés, afin de tester et de modifier des applications sans connecter 
de matériel ; reportez-vous au fichier Readme de NI-DAQ pour obtenir 
la liste des périphériques supportés par NI-DAQmx qui ne peuvent pas 
être simulés par NI-DAQmx.
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• Des API plus simples et plus intuitives pour créer des applications 
DAQ en utilisant moins de fonctions et de VIs, comparé aux versions 
antérieures de NI-DAQ.

NI-DAQ traditionnel est un ancien driver dont les API (obsolètes) 
permettent de développer des applications d’acquisition de données, 
d’instrumentation et de contrôle conçues pour les anciens périphériques 
DAQ de National Instruments. Vous devriez utiliser NI-DAQ traditionnel 
(ancien driver) uniquement dans certaines circonstances. Reportez-vous au 
fichier Readme de NI-DAQ pour savoir dans quels cas l’utilisation de 
NI-DAQ traditionnel (ancien driver) se justifie, et pour obtenir des 
informations complémentaires, notamment la liste des périphériques, 
systèmes d’exploitation et versions de logiciel d’application et de langages 
supportés. 

Étape 1. Installez le logiciel d’application
Installez votre logiciel d’application NI. Pour utiliser NI-DAQmx, installez 
LabVIEW 7.x ou version ultérieure, LabWindows/CVI 7.x ou version 
ultérieure, Measurement Studio7.x ou version ultérieure, VI Logger 2.x ou 
le Module LabVIEW Real-Time 7.1 ou version ultérieure.

Si vous avez une application qui a été développée avec une version 
antérieure de votre logiciel d’application ou de NI-DAQ, faites-en une 
copie de sauvegarde. Vous pouvez ensuite mettre à jour votre logiciel et 
modifier l’application.

Étape 2. Installez NI-DAQ 8.x
Installez le logiciel de drivers avant d’installer de nouveaux périphériques 
matériels, de sorte que Windows puisse détecter vos périphériques. 
N’installez pas NI-DAQ 8.x si vos applications existantes comportent des 
composants non supportés listés dans le fichier Readme de NI-DAQ.

1. Insérez le CD. L’installeur NI-DAQ 8.x devrait s’ouvrir 
automatiquement. Si ce n’est pas le cas, sélectionnez Démarrer» 
Exécuter. Entrez x:\autorun.exe, x correspondant à la lettre du 
lecteur de CD. Pour consulter des instructions de dépannage, 
reportez-vous à la rubrique Hardware Installation/Configuration 
Troubleshooter sur ni.com/support/install.

2. Installez le logiciel. 

• Installer copie les fichiers du logiciel et/ou de la documentation 
sur votre disque dur. La documentation du logiciel NI-DAQ est 
installée lorsque vous installez le logiciel de drivers. 
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• Consulter ouvre la documentation sur les périphériques pour 
vous permettre de rechercher, d’afficher et d’imprimer des 
documents sans les installer. 

Attention NI-DAQ 7.x ou version ultérieure ne peut pas coexister sur le même ordinateur 
avec des versions de NI-DAQ antérieures à la version 7.0.

3. Installez les fichiers support. L’installeur NI-DAQ détecte tous les 
logiciels NI installés sur le système et choisit autohellomatiquement 
sur le CD les fichiers support des versions les plus récentes des drivers, 
des logiciels d’application et des langages qu’il a détectés. Vérifiez 
que l’installeur a détecté et sélectionné les fichiers support corrects et 
le bon numéro de version.

Si vous installez NI-DAQ avant d’installer un logiciel d’application NI 
de la version 7.x ou ultérieure, vous devez à nouveau exécuter 
l’installeur NI-DAQ afin d’installer le fichier support qui convient pour 
ce logiciel d’application.

4. Cliquez sur Suivant aux invites.

5. Cliquez sur Terminer.

6. Une fois que l’installeur NI-DAQ a terminé, un message apparaît pour 
vous demander si vous voulez quitter, arrêter ou redémarrer.

• Cliquez sur Quitter pour installer un autre logiciel NI ou de la 
documentation supplémentaire. 

– Installez la documentation en ligne pour les périphériques et 
les accessoires supportés, notamment des fichiers PDF et des 
fichiers d’aide décrivant les terminaux, les spécifications, les 
fonctionnalités et le mode d’opération du périphérique. 
Réinsérez le CD NI-DAQ pour rouvrir l’écran de l’installeur. 
Sélectionnez Installer la documentation sur les 
périphériques. 

– Si vous utilisez un lien MXI-3 à partir d’un PC pour contrôler 
un châssis PXI, vous devez quitter le programme et installer 
le logiciel MXI-3, disponible sur ni.com/downloads, avant 
d’utiliser le périphérique DAQ.

• Cliquez sur Arrêter si vous êtes prêt à installer votre 
périphérique.

• Cliquez sur Redémarrer si vous utilisez un système qui exécute 
le Module LabVIEW Real-Time. Téléchargez NI-DAQ 8.x vers la 
cible à l’aide de MAX (Measurement & Automation Explorer). 
Reportez-vous à l’Aide Measurement & Automation Explorer sur 
les systèmes déportés en sélectionnant Aide»Rubriques de 
l’aide»Systèmes déportés.
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Étape 3. Déballez les périphériques, les accessoires et 
les câbles

Retirez le périphérique de son emballage et examinez les composants pour 
repérer tout signe d’endommagement. Contactez NI si le périphérique 
apparaît endommagé d’une façon quelconque. N’installez pas un 
périphérique endommagé.

Vous trouverez des informations sur la sécurité et la conformité dans la 
documentation sur les périphériques, disponible sur ni.com/manuals ou 
à partir de Démarrer»Programmes»National Instruments»NI-DAQ» 
Browse Device Documentation après l’avoir installée. 

Les symboles suivants peuvent figurer sur votre périphérique.

Cette icône signale un avertissement qui vous indique les précautions à 
prendre pour éviter des préjudices corporels, des pertes de données ou un 
blocage du système. Si ce symbole est présent sur le périphérique, 
reportez-vous au document Read Me First: Safety and Radio-Frequency 
Interference, livré avec le périphérique, pour vous renseigner sur les 
précautions à prendre.

La présence de ce symbole sur un produit indique une mise en garde vous 
conseillant de prendre des précautions pour éviter les chocs électriques.

La présence de ce symbole sur un produit indique qu’un composant risque 
d’être brûlant. Toucher ce produit peut provoquer des préjudices corporels.

Étape 4. Installez les périphériques, les accessoires et 
les câbles

Si vous avez plusieurs périphériques DAQ à installer, installez-les tous 
maintenant. Si votre système comporte des modules SCXI à connecter à 
des périphériques DAQ, installez d'abord les composants DAQ.

Attention Respectez les précautions à suivre contre les dommages électrostatiques avant 
d’installer le matériel. Consultez le document des spécifications se rapportant à votre 
périphérique pour lire des informations importantes concernant la sécurité et la 
compatibilité. 

Vous pouvez tester des applications NI-DAQmx sans installer de matériel 
en utilisant un périphérique simulé NI-DAQmx. Reportez-vous à l’Aide 
Measurement & Automation Explorer pour NI-DAQmx en sélectionnant 
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Aide»Rubriques de l’aide»NI-DAQmx pour obtenir des informations sur 
la création de périphériques simulés NI-DAQmx. 

Périphériques PCI et PCI Express
Effectuez les étapes suivantes pour installer un périphérique PCI ou 
PCI Express :

1. Mettez le châssis hors tension et débranchez-le de l’ordinateur.

2. Retirez le capot de votre ordinateur et/ou le cache de l’emplacement 
d’extension.

3. Touchez n’importe quelle partie métallique de l’ordinateur pour 
décharger l’électricité statique.

4. Insérez le périphérique dans l’emplacement PCI ou PCI Express 
approprié. Faites-le basculer doucement pour qu’il se mette 
complètement en place. Ne forcez pas le périphérique dans son 
emplacement.

Figure 1.  Installation d’un périphérique PCI

Conformément à la norme PCI, les périphériques DAQ NI PCI qui 
possèdent le connecteur Universal PCI sont supportés par les bus 
conformes PCI, y compris PCI-X. Vous ne pouvez pas installer de 
périphériques PCI Express dans des emplacements PCI et vice versa. 
Les périphériques PCI Express supportent le branchement dans des 
connecteurs PCI Express plus larges (up-plugging). Sur certaines 
cartes mères, l’emplacement x16 est réservé aux cartes graphiques ; 
consultez les instructions du constructeur pour tenter de trouver 
d’autres solutions pour connecter une carte graphique si vous utilisez 
l’emplacement x16 pour une carte autre qu'une carte graphique. Pour 

1 Périphérique DAQ PCI
2 Emplacement système PCI

3 PC avec emplacement PCI

3

1
2
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obtenir des directives sur l'utilisation de PCI Express, reportez-vous à 
ni.com/pciexpress.

5. Fixez le support de fixation du périphérique au rail du panneau arrière 
de l’ordinateur.

6. Remettez en place le capot de l’ordinateur.

Périphériques PCMCIA
Vous pouvez installer le périphérique NI PCMCIA dans n’importe quel 
emplacement de carte PC de type II disponible. Effectuez les étapes 
suivantes.

1. Si nécessaire, retirez le cache de protection de l’emplacement 
PCMCIA.

2. Insérez le connecteur de bus PCMCIA du périphérique PCMCIA dans 
l’emplacement jusqu'à ce qu’il soit solidement installé.

Figure 2.  Installation d’un périphérique PCMCIA dans un ordinateur portable

3. Branchez le câble d’E/S. Prenez garde de ne pas tirer trop fort sur le 
câble d'E/S quand vous insérez ou retirez son connecteur. Saisissez 
toujours le câble par son connecteur quand vous le connectez ou 
l’enlevez. Ne tirez jamais directement sur le câble d’E/S pour le 
débrancher du périphérique PCMCIA.

1 Ordinateur avec emplacement PCMCIA
2 Prise PCMCIA
3 Périphérique PCMCIA

4 Câble d’E/S blindé
5 Accessoire
6 Lignes des signaux

®

®

DAQCard
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2
3

4

5
6



© National Instruments Corporation 23 Guide d’initiation DAQ

Périphériques PXI
Effectuez les étapes suivantes pour installer le module PXI.

1. Mettez le châssis PXI hors tension et débranchez-le.

Attention Reportez-vous au document Read Me First: Safety and Radio-Frequency 
Interference livré avec votre châssis ou périphérique PXI avant de retirer le couvercle du 
matériel ou de connecter et de déconnecter des câbles de signal.

2. Retirez le cache de protection d’un emplacement PXI vide. Pour savoir 
quels emplacements utiliser dans le châssis, reportez-vous à la 
documentation sur les périphériques, comme expliqué dans l’Étape 2. 
Installez NI-DAQ 8.x.

3. Touchez n’importe quelle partie métallique du châssis pour décharger 
l’électricité statique.

4. Vérifiez que la poignée d’insertion/éjection du module PXI n’est pas 
verrouillée et qu’elle tourne librement.

5. Placez les bords du module PXI dans les guides pour module en haut 
et en bas du châssis.

6. Faites glisser le périphérique dans l’emplacement PXI à l’arrière du 
châssis.

7. Dès que vous sentez une résistance, relevez la poignée 
d’insertion/éjection pour insérer complètement le périphérique.

8. Vissez le périphérique sur le support de fixation situé à l’avant du 
châssis à l’aide des vis de montage.
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Figure 3.  Installation d’un périphérique PXI

Périphériques USB
Exécutez ces étapes pour installer un périphérique NI de type USB :

1. Effectuez les connexions d’alimentation.

• Si vous utilisez un pack batterie BP-1, suivez les instructions de 
votre guide d’installation BP-1.

• Certains périphériques NI de type USB nécessitent une 
alimentation externe.

– Si votre périphérique utilise une alimentation externe, 
assurez-vous que la tension sur le bloc d’alimentation 
externe, le cas échéant, est compatible avec le courant secteur 
dans votre région (120 ou 230 VAC) et avec la tension exigée 
par votre périphérique. Connectez une extrémité du bloc 
d’alimentation à une prise secteur et branchez l’autre 
extrémité au périphérique.

– Si votre périphérique est muni d’un cordon d’alimentation, 
connectez une extrémité du cordon d’alimentation au 
périphérique et l’autre à une prise secteur.

2. Connectez le câble branché dans le port USB de l’ordinateur ou tout 
autre hub à un port USB disponible du périphérique. 

1 Châssis PXI
2 Contrôleur système PXI
3 Module PXI
4 Poignée d’insertion/éjection

5 Vis de montage du panneau avant
6 Guides pour module
7 Interrupteur d’alimentation

3

1

2

4

PXI-1000B

7
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3. Si votre périphérique USB est équipé d’un bouton d’alimentation, 
mettez-le sous tension. L’ordinateur devrait détecter immédiatement 
votre périphérique.

Accessoires
Installez les accessoires et/ou les blocs de connexion suivant les 
instructions fournies dans leurs guides d’installation respectifs. Pour les 
systèmes de conditionnement de signal SCXI et SCC, continuez à suivre les 
instructions de ce guide jusqu’à l’Étape 8. Installez les périphériques de 
conditionnement de signal ou de commutation.

Étape 5. Mettez votre ordinateur ou châssis PXI sous 
tension

Windows détecte et reconnaît tous les périphériques nouvellement installés 
dès le premier redémarrage qui suit l’installation. Sur certains systèmes 
Windows, l’Assistant Nouveau matériel détecté s’ouvre avec une boîte de 
dialogue pour chaque périphérique NI installé. Installer le logiciel 
automatiquement (Recommandé) est sélectionné par défaut. Cliquez sur 
Suivant ou sur Oui pour installer le logiciel de chaque périphérique.

Lorsque l’ordinateur reconnaît un périphérique USB, le voyant LED 
d’alimentation clignote ou s'allume. Reportez-vous à la documentation sur 
le périphérique pour obtenir une explication des états de la LED. 

Étape 6. Confirmez que le périphérique est reconnu
Suivez ces étapes :

1. Double-cliquez sur l'icône Measurement & Automation qui se 
trouve sur le bureau pour ouvrir MAX.

2. Développez la catégorie Périphériques et interfaces puis la catégorie 
Périphériques NI-DAQmx. Si vous utilisez une cible RT déportée, 
développez l’élément Systèmes déportés, recherchez et développez 
votre cible, et développez ensuite la catégorie Périphériques et 
interfaces. Vous trouverez des instructions de configuration de 
NI-DAQ traditionnel (ancien driver) dans le fichier Readme de 
NI-DAQ traditionnel (ancien driver), accessible à partir de 
Démarrer»Programmes»National Instruments»NI-DAQ lorsque 
le logiciel a été installé.
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3. Vérifiez que votre périphérique apparaît bien sous Périphériques et 
interfaces. Si votre périphérique n’apparaît pas, appuyez sur <F5> 
pour rafraîchir l’affichage dans MAX. Si votre périphérique n’est 
toujours pas reconnu, reportez-vous à la page ni.com/support/ 
install.

4. Faites un clic droit sur le périphérique et sélectionnez Auto-test.
 

Si vous avez besoin d’aide au cours de l’auto-test, ouvrez Aide 
Measurement & Automation Explorer pour NI-DAQmx en 
sélectionnant Aide»Rubriques de l’aide»NI-DAQmx. Au terme de 
l’auto-test, un message s’affiche, indiquant si la vérification s’est 
déroulée sans problème ou si une erreur a eu lieu. Si une erreur s’est 
produite, reportez-vous à ni.com/support/install pour obtenir 
des informations de dépannage.

1 Quand un périphérique est supporté à la fois par NI-DAQmx et NI-DAQ 
traditionnel (ancien driver) et que ces deux drivers sont installés, le même 
périphérique apparaît sous un nom différent sous Système»Périphériques et 
interfaces. 

2 Seuls les périphériques NI-DAQmx sont recensés sous Systèmes déportés» 
Périphériques et interfaces. 

1

2
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Vous pouvez tester des applications NI-DAQmx sans installer de 
matériel en utilisant un périphérique simulé NI-DAQmx. 
Reportez-vous à l’Aide Measurement & Automation Explorer pour 
NI-DAQmx en sélectionnant Aide»Rubriques de l’aide»NI-DAQmx 
pour obtenir des instructions sur la manière de créer des périphériques 
simulés NI-DAQmx, et sur la manière d’importer des configurations 
de périphériques simulés NI-DAQmx sur des périphériques matériels. 

Étape 7. Configurez les paramètres du périphérique
Configurez chaque périphérique que vous installez :

1. Effectuez un clic droit sur le nom du périphérique et sélectionnez 
Propriétés. Assurez-vous de cliquer sur le nom du périphérique se 
trouvant dans le dossier du système (Système ou Systèmes déportés) et 
de l’API de NI-DAQ que vous voulez utiliser pour contrôler le 
périphérique. 

2. Configurez les propriétés du périphérique. Pour utiliser un 
périphérique à la fois dans NI-DAQmx et dans NI-DAQ traditionnel 
(ancien driver), vous devez le configurer dans chacun de ces drivers.

• Si vous utilisez un accessoire, ajoutez les informations qui le 
concernent.

• Pour des capteurs et des accessoires TEDS (Transducer Electronic 
Data Sheet) IEEE 1451.4, configurez le périphérique et ajoutez les 
accessoires comme décrit plus haut. Cliquez sur Recherche de 
TEDS. Pour configurer des capteurs TEDS qui sont connectés 
directement à un périphérique, faites un clic droit dans MAX sur 
le périphérique figurant sous Périphériques et interfaces et 
sélectionnez Configurer un TEDS.

3. Cliquez sur OK pour valider les changements.

Étape 8. Installez les périphériques de conditionnement 
de signal ou de commutation

Si votre système comporte des modules de conditionnement de signal 
SCXI et SCC (Signal Conditioning Components), comme les boîtiers SC et 
les modules SCC, des bloc de terminaison ou des modules de commutation, 
reportez-vous au guide d’initiation du produit pour installer et configurer le 
matériel de conditionnement de signal ou de commutation.

Le reste de ce guide s’applique aux périphériques DAQ et aux 
périphériques de conditionnement de signal intégré PXI.
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Étape 9. Connectez les lignes de capteurs et de signaux
Connectez les capteurs et les lignes de signaux au bloc de connexion ou aux 
accessoires. 

Vous pouvez afficher et imprimer un schéma des connexions pour les 
tâches et les voies virtuelles NI-DAQmx dans votre système à l’aide de 
l’Assistant DAQ. Sélectionnez la tâche ou la voie virtuelle et cliquez sur 
l’onglet Diagramme des connexions. Sélectionnez chaque voie virtuelle 
dans la tâche pour afficher les connexions entre les capteurs et les blocs de 
connexion. 

Les affectations de broches sont également indiquées dans la 
documentation du périphérique qui se trouve dans l’explorateur Device 
Document Browser, accessible à partir de Démarrer»Programmes» 
National Instruments»NI-DAQ»Browse Device Document une fois la 
documentation installée, et dans Device Pinouts de l’Aide Measurement & 
Automation Explorer pour NI-DAQmx.

Pour obtenir des informations sur les capteurs, reportez-vous à la page 
ni.com/sensors ou à la rubrique Sensors de NI-DAQmx Help, accessible 
à partir de Démarrer»Programmes»National Instruments»NI-DAQ» 
NI-DAQmx Help. Pour obtenir des informations sur les capteurs 
intelligents TEDS IEEE 1451.4, consultez le site ni.com/zone. 

Les spécifications d’un module de commutation comprennent une 
topologie de ce périphérique.

Étape 10. Exécutez les panneaux de test
De nombreux périphériques comportent un panneau de test pour tester des 
fonctionnalités spécifiques à ce périphérique, par exemple sa capacité à 
acquérir ou à générer des signaux. 

1. Dans MAX, développez la catégorie Périphériques et interfaces» 
Périphériques NI-DAQmx. Si vous utilisez une cible RT déportée, 
développez l’élément Systèmes déportés, recherchez et développez 
votre cible, et développez ensuite la catégorie Périphériques et 
interfaces.

2. Cliquez avec le bouton droit sur le périphérique à tester. 

3. Sélectionnez Panneaux de test pour ouvrir le panneau de test 
correspondant au périphérique sélectionné, comme le montre 
l’exemple suivant.
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4. Cliquez sur les onglets pour tester différentes fonctions du 
périphérique. Cliquez sur Aide pour obtenir des instructions sur 
l’utilisation des panneaux de test.

5. Le panneau de test affiche un message indiquant si une erreur s’est 
produite. Reportez-vous à NI-DAQmx Help ou à ni.com/france/ 
support pour obtenir des informations de dépannage. 

6. Cliquez sur Fermer pour quitter le panneau de test.

Si vous avez installé plus d’un périphérique DAQ, répétez l’Étape 7. 
Configurez les paramètres du périphérique à l’Étape 10. Exécutez les 
panneaux de test pour chacun d’eux. 

Étape 11. Configurez les voies et les tâches
Cette étape ne s’applique que si vous programmez votre périphérique à 
l’aide de NI-DAQmx ou d’un logiciel d’application NI. 

Une tâche, concept essentiel de NI-DAQmx, est constituée d’une ou de 
plusieurs voies virtuelles et de propriétés de cadencement, de 
déclenchement et autres. Fondamentalement, une tâche représente la 
mesure ou la génération à réaliser. Vous pouvez définir et enregistrer toutes 
les informations de configuration dans une tâche et l’utiliser dans une 
application.

Dans NI-DAQmx, les voies virtuelles peuvent être définies comme faisant 
partie d’une tâche ou être configurées séparément de celle-ci. Les voies 
virtuelles créées à l’intérieur d'une tâche sont des voies virtuelles locales. 
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Les voies virtuelles créées à l’extérieur d’une tâche sont des voies virtuelles 
globales. Vous pouvez créer des voies virtuelles globales dans MAX ou 
dans votre application logicielle, puis les enregistrer sous MAX. Vous 
pouvez utiliser les voies virtuelles globales dans n’importe quelle 
application ou les ajouter à différentes tâches. Si vous modifiez une voie 
virtuelle globale, les changements affectent toutes les tâches dans 
lesquelles cette voie est utilisée. 

Configuration d’une tâche dans NI-DAQmx
Lorsque vous utilisez NI-DAQmx, configurez les tâches à l’aide de 
l’Assistant DAQ. Vous devez avoir la version 7.0 ou une version ultérieure 
du logiciel d’application NI pour créer des tâches et des voies virtuelles 
avec l’Assistant DAQ.

• Dans MAX, cliquez avec le bouton droit sur Voisinage de données et 
sélectionnez Créer un nouvel objet. Dans la fenêtre Créer un nouvel 
objet, sélectionnez Tâche NI-DAQmx, puis cliquez sur Suivant. Si 
vous utilisez une cible RT déportée, vous devez d’abord développer 
l’élément Systèmes déportés, puis rechercher et développer votre 
cible pour voir Voisinage de données.

• Vous pouvez également ouvrir directement l’Assistant DAQ à partir de 
votre logiciel d’application NI :

– Dans LabVIEW, déposez le VI Express Assistant DAQ sur le 
diagramme à partir de la palette “Entrée” des VIs Express, comme 
expliqué dans le manuel Initiation à LabVIEW.

Vous pouvez également ouvrir l’Assistant DAQ en cliquant avec 
le bouton droit sur la commande Nom de tâche DAQmx de la 
palette de commandes Nom DAQmx et en sélectionnant Nouvelle 
tâche (Assistant DAQ). Le tutorial d’aide Prendre une mesure 
NI-DAQmx dans LabVIEW contient des instructions pas à pas 
pour créer une tâche à partir de la commande Nom de tâche 
DAQmx et générer le code associé à la tâche. Dans LabVIEW, 
sélectionnez Aide»Prendre une mesure NI-DAQmx.

– Dans LabWindows/CVI :

1. Sélectionnez Tools»Create/Edit DAQmx Tasks. La boîte 
de dialogue Create/Edit DAQmx Tasks s’ouvre. 

2. Sélectionnez Create New Task In MAX ou Create New 
Task In Project et cliquez sur OK.

– Dans Measurement Studio :

1. Ouvrez Visual Studio .NET et le projet dans lequel vous 
voulez créer une classe de tâche DAQmx.

2. Sélectionnez Project»Add New Item. La boîte de dialogue 
Add New Item s’affiche. 
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3. Dans la sous-fenêtre Categories, sélectionnez Measurement 
Studio»Assistants.

4. Dans la sous-catégorie Templates, sélectionnez DAQmx 
Task Class.

5. Spécifiez le nom du fichier de tâche DAQmx et cliquez sur 
Open. 

6. Précisez si vous voulez créer une nouvelle tâche ou faire une 
copie de projet d’une tâche globale créée dans MAX et 
cliquez sur Terminer.

L'Assistant DAQ vous invite à créer une nouvelle tâche en sélectionnant le 
type d'E/S (entrée analogique, par exemple), la mesure ou la génération à 
effectuer, le capteur qui fera la mesure, et la ou les voies physiques à partir 
desquelles les voies virtuelles locales de la tâche seront créées. Si vous avez 
déjà configuré des voies virtuelles globales pour le type de mesure souhaité, 
cliquez sur l'onglet Virtuelles pour copier ou ajouter des voies virtuelles 
globales à la tâche. Reportez-vous à l'Aide Assistant DAQ pour obtenir des 
instructions sur la création de tâches.

Configuration de voies virtuelles globales dans NI-DAQmx
Si vous souhaitez utiliser des voies virtuelles dans plusieurs applications ou 
tâches NI-DAQmx, configurez les voies virtuelles globales avec l'Assistant 
DAQ. Vous pouvez lancer l'Assistant DAQ pour créer une voie virtuelle 
globale dans MAX ou dans LabVIEW.

• Pour ouvrir l'Assistant DAQ dans MAX, faites un clic droit sur 
Voisinage de données et sélectionnez Créer un nouvel objet. Dans 
la fenêtre Créer un nouvel objet, sélectionnez Voie virtuelle globale 
NI-DAQmx puis cliquez sur Suivant. 

• Pour ouvrir l'Assistant DAQ directement dans LabVIEW afin de créer 
une voie virtuelle globale, déposez une commande Voie globale 
DAQmx sur la face-avant, cliquez dessus avec le bouton droit et 
sélectionnez Nouvelle voie DAQmx.

L'Assistant DAQ vous invite à créer une nouvelle voie virtuelle globale en 
sélectionnant le type d'E/S (entrée analogique, par exemple), la mesure ou 
la génération à effectuer, le capteur qui fera la mesure, et la voie physique 
à partir de laquelle la voie virtuelle globale sera créée. Reportez-vous à 
l'Aide Assistant DAQ pour obtenir des instructions sur la création de tâches 
et des voies virtuelles et savoir comment les utiliser dans une application.

Dans LabWindows/CVI et Measurement Studio, vous ne pouvez pas 
directement créer une voie virtuelle globale, vous devez la créer dans MAX 
comme cela est expliqué précédemment.
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Vous pouvez ajouter ou copier une voie virtuelle globale dans une tâche à 
partir du logiciel d'application.

1. Lancez l'Assistant DAQ, comme décrit dans la section Configuration 
d’une tâche dans NI-DAQmx. 

2. Cliquez sur le bouton Ajouter des voies ( ). 

3. Dans l'onglet Virtuelles, sélectionnez une voie virtuelle globale à 
copier ou à ajouter dans la boîte de dialogue Ajouter des voies à la 
tâche.

Étape 12. Utilisez votre périphérique dans une 
application

Assistant DAQ
Effectuez les étapes suivantes pour utiliser une tâche de mesure dans votre 
application ou générer du code. Reportez-vous à l’Aide Assistant DAQ pour 
obtenir de plus amples informations.

LabVIEW
1. Ouvrez un VI vide dans LabVIEW. 

2. Placez la constante suivante sur le diagramme : Mesures NI» 
Acquisition de données DAQmx»Constante de nom de tâche 
DAQmx.

3. Sélectionnez la tâche dans la liste déroulante. 

4. Faites un clic droit sur le VI et sélectionnez Générer le code» 
Exemple. 

5. Exécutez le programme à partir de la face-avant.

LabWindows/CVI
Reportez-vous à ni.com/info et tapez rddq73 pour obtenir des 
instructions pas à pas sur l'utilisation d'une tâche dans LabWindows/CVI.

Measurement Studio
Reportez-vous à ni.com/info et tapez rddqms pour obtenir des 
instructions pas à pas sur l'utilisation d'une tâche dans Measurement Studio.
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Exemples
Vous pouvez utiliser les exemples pour développer une nouvelle 
application ou ajouter le code des exemples dans une application existante.

Pour consulter d’autres exemples, visitez le site ni.com/zone.

Pour exécuter des exemples sans matériel installé, vous pouvez utiliser un 
périphérique simulé NI-DAQmx. Dans MAX, reportez-vous à l’Aide 
Measurement & Automation Explorer pour NI-DAQmx en sélectionnant 
Aide»Rubriques de l’aide»NI-DAQmx pour obtenir des informations sur 
la création de périphériques simulés NI-DAQmx. 

VI Logger Lite
Le CD NI-DAQmx comprend VI Logger Lite, un outil basé sur 
configuration et facile à utiliser, conçu spécifiquement pour les 
applications d’enregistrement de données.  L’application est disponible à 
partir de Démarrer»Programmes»National Instruments»VI Logger. 
L’aide, VI Logger Help, est disponible dans MAX sous Aide»Rubriques 
de l’aide»VI Logger.

Informations supplémentaires
Après l'installation de la documentation sur les périphériques, vous pouvez 
accéder à l’explorateur et à la documentation des périphériques à partir de 
Démarrer»Programmes»National Instruments»NI-DAQ»Browse 
Device Documentation. Les documents sur le logiciel NI-DAQ, comme 
NI-DAQmx Help et le Guide d’initiation DAQ, sont disponibles sous 
Démarrer»Programmes»National Instruments»NI-DAQ»titre du 
document NI-DAQmx.

Application logicielle Emplacement des exemples

LabVIEW ou LabWindows/CVI Aide»Recherche d’exemples

Langages supportés par Measurement Studio 

MFC C++ 

Exemples Visual Basic .NET et C#*

MeasurementStudioVS2003\VCNET\ 

Examples\DAQmx

MeasurementStudioVS2003\DotNET\ 

Examples\DAQmx

ANSI C NI-DAQ\Examples\DAQmx ANSI C

* Measurement Studio n’est pas exigé
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Dépannage
Utilisez les ressources suivantes si vous vous heurtez à des problèmes lors 
de l’installation de votre matériel et/ou logiciel DAQ :

• Pour consulter des instructions de dépannage, reportez-vous à la 
rubrique Hardware Installation/Configuration Troubleshooter sur 
ni.com/support/install.

• Reportez-vous à ni.com/kb pour accéder aux documents se 
rapportant au dépannage des problèmes courants d’installation et de 
programmation, et pour obtenir les réponses aux questions les plus 
fréquentes concernant les produits NI.

• Si vous pensez avoir endommagé votre périphérique et que vous jugez 
devoir retourner votre matériel National Instruments pour le faire 
réparer ou étalonner, reportez-vous à ni.com/info et entrez le code 
rdsenn pour savoir comment procéder pour obtenir une autorisation 
de renvoi de marchandise.

Support technique dans le monde entier
Pour obtenir un support complémentaire, visitez le site ni.com/france/ 
support ou ni.com/zone. Pour obtenir des informations de support 
supplémentaires sur les produits de conditionnement de signal, 
reportez-vous au document Signal Conditioning Technical Support 
Information fourni avec votre périphérique.

Le siège social de National Instruments est situé à cette adresse : 11500 
North Mopac Expressway, Austin, Texas, 78759-3504, États-Unis. 
National Instruments compte aussi des filiales dans le monde entier pour 
répondre à vos besoins de support.



Erste Schritte mit NI-DAQ
In der vorliegenden Broschüre erhalten Sie eine Anleitung zur Installation 
eines Datenerfassungsgeräts sowie der Treibersoftware NI-DAQmx 8.x 
und Sie erfahren, wie das Gerät auf Funktionstüchtigkeit überprüft wird. 
Die Konfiguration des traditionellen NI-DAQ-Treibers (alt) ist in der 
Readme zum traditionellen NI-DAQ-Treiber beschrieben, die nach der 
Installation des Treibers über Start»Programme»National Instruments» 
NI-DAQ geöffnet werden kann.

NI-DAQ
Alle messtechnischen Geräte von National Instruments, wie MIO-Karten 
der M-Serie, Signalkonditionierungs- oder Schaltmodule, werden mit dem 
NI-DAQ-Treiber geliefert, zu dem es eine umfangreiche VI-Bibliothek und 
ANSI-C-Funktionen für Entwicklungsumgebungen wie LabVIEW oder 
LabWindows™/CVI™ gibt. Der Treiber ist mit einer eigenen API  in Form 
einer Bibliothek von VIs, Funktionen, Klassen, Attributen und Eigenschaf-
ten ausgestattet, mit der Sie Programme für Ihre Geräte erstellen können.

NI-DAQ-Versionen ab 7.x umfassen zwei eigenständige NI-DAQ-Treiber 
mit jeweils eigener Funktionen- und VI-Bibliothek sowie Hardware- und 
Softwarekonfiguration. NI-DAQmx ist der neueste NI-DAQ-Treiber. Er 
weist gegenüber dem traditionellen NI-DAQ-Treiber folgende Vorteile 
auf:

• Zu NI-DAQmx gehört ein so genannter DAQ-Assistent. Darin können 
Sie virtuelle Kanäle und Tasks für Messungen mit einem bestimmten 
Gerät konfigurieren und diese Einstellungen in Programmcode für 
LabVIEW, LabWindows/CVI, Measurement Studio und VI Logger 
umwandeln lassen.

• Leistungsfähigere Funktionen, zum Beispiel schnellere Erfassung und 
Ausgabe einzelner Werte oder Multithreading.

• Simulation der meisten Geräte, die NI-DAQmx unterstützt (die genaue 
Liste finden Sie in der NI-DAQ Readme), so dass Sie Ihre Applikatio-
nen ohne die Hardware testen können.

• Einfachere, intuitiver gestaltete Programmieroberfläche, die mit weni-
ger VIs und Funktionen als frühere NI-DAQ-Versionen auskommt.
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Der traditionelle NI-DAQ-Treiber ist ein älterer Treiber, der nur noch mit 
bestimmten DAQ-Karten von National Instruments arbeitet. Er sollte daher 
nur in Ausnahmefällen verwendet werden. Einzelheiten dazu finden Sie in 
der NI-DAQ Readme, die auch eine Übersicht der Geräte, Betriebssysteme, 
Entwicklungsumgebungen und Programmiersprachen enthält, die mit dem 
Treiber kompatibel sind. 

Schritt 1: Installation der Entwicklungsumgebung
Installieren Sie Ihre Entwicklungsumgebung von National Instruments. 
Für NI-DAQmx wird mindestens LabVIEW 7.x, LabWindows/CVI 7.x, 
Measurement Studio 7.x, VI Logger 2.x oder das LabVIEW Real-Time 
Module ab Version 7.1 benötigt.

Von Applikationen, die mit einer früheren Version einer Entwicklungsum-
gebung von National Instruments oder des NI-DAQ-Treibers erstellt 
wurden, sollte eine Sicherheitskopie angelegt werden, so dass die Applika-
tionen nach Aktualisierung der Software ohne jedes Risiko verändert 
werden können.

Schritt 2: Installation von NI-DAQ 8.x
Installieren Sie den Treiber vor Anschluss der neuen Geräte, da die Geräte 
so automatisch erkannt werden. Installieren Sie NI-DAQ 8.x nicht, wenn in 
Ihren Applikationen Komponenten enthalten sind, die von diesem Treiber 
nicht unterstützt werden (siehe dazu die Datei NI-DAQ Readme).

1. Legen Sie die CD ein. Es sollte sich automatisch der NI-DAQ-Instal-
lationsassistent öffnen. Falls nicht, wählen Sie Start»Ausführen und 
geben Sie x:\autorun.exe ein (x steht dabei für den Buchstaben des 
CD-Laufwerks). Bei Problemen besuchen Sie bitte unsere Website 
ni.com/support/install und gehen Sie nach den Anweisungen 
im Hardware Installation/Configuration Troubleshooter vor.

2. Installieren Sie die Software. 

• Mit Installieren wird die Software bzw. Dokumentation auf Ihre 
Festplatte kopiert. Die Dokumentation zu NI-DAQ wird automa-
tisch zusammen mit dem Treiber installiert. 

• Mit Anzeigen gelangen Sie zur Dokumentation der Hardware, wo 
Sie nach Themen suchen und diese ohne vorherige Installation 
öffnen und ausdrucken können. 

Vorsicht! NI-DAQ-Versionen ab 7.x dürfen nicht zusammen mit NI-DAQ-Versionen vor 
7.0 auf dem System installiert sein. 
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3. Installieren Sie die Hilfsdateien. Der NI-DAQ-Installationsassistent 
erkennt automatisch die auf dem Computer vorhandene Software von 
National Instruments und wählt automatisch die neueste Version des 
Treibers, der Entwicklungsumgebung oder der Hilfsdateien für Pro-
grammiersprachen von der CD aus. Überprüfen Sie, ob die auto- 
matische Auswahl korrekt ist.

NI-DAQ muss immer nach Entwicklungsumgebungen von National 
Instruments der Version 7.x installiert werden. Wenn Sie zuerst 
NI-DAQ installiert haben, starten Sie den Installer für den Treiber 
noch einmal, damit die fehlenden Hilfsdateien hinzugefügt werden.

4. Klicken Sie auf Weiter, bis Sie beim letzten Dialogfeld des Installers 
angelangt sind.

5. Klicken Sie auf Beenden.

6. Am Ende des Installationsvorgangs werden Sie gefragt, ob Sie das Pro-
gramm beenden oder den Computer herunterfahren oder neu starten 
möchten.

• Wenn Sie noch andere Software von National Instruments instal-
lieren möchten, wählen Sie Beenden. 

– Installieren Sie die PDF- und Hilfedateien zur Hardware, für 
die der Treiber vorgesehen ist. Darin sind die technischen 
Daten sowie die Pinbelegungen, Leistungsmerkmale und 
Informationen zur Betriebsweise der Hardware enthalten. 
Legen Sie die NI-DAQ-CD nochmals ein, so dass sich das 
Installer-Fenster öffnet, und wählen Sie Install Device 
Documentation. 

– Wenn Ihr PC über eine MXI-3-Schnittstelle mit einem PXI- 
Chassis verbunden ist, verlassen Sie das Programm und 
installieren Sie die MXI-3-Software, die bei Bedarf auch von 
der Website ni.com/downloads heruntergeladen werden 
kann.

• Herunterfahren sollte ausgewählt werden, wenn alles zum 
Anschließen der Hardware bereit ist.

• Neustart ist beim LabVIEW Real-Time Module erforderlich. 
Laden Sie mit Hilfe des Measurement & Automation Explorers 
(MAX) NI-DAQ 8.x auf das Netzwerksystem herunter. Hilfe dazu 
erhalten Sie in der Measurement & Automation Explorer-Hilfe zu 
Systemen im Netzwerk, die sich unter Hilfe»Hilfethemen» 
Netzwerkumgebung befindet.
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Schritt 3: Auspacken der Geräte, Zusatzbauteile und 
Kabel

Packen Sie die Karte aus und überprüfen Sie, ob sich eventuell Teile davon 
gelöst haben, oder ob sie anderweitig beschädigt ist. Sollte die Karte schad-
haft erscheinen, setzen Sie sich bitte mit uns in Verbindung. Bauen Sie auf 
keinen Fall eine defekte Karte ein!

Sicherheitshinweise und Informationen zur Einhaltung von Sicherheits-
standards finden Sie auf ni.com/manuals und in der Dokumentation, die 
nach der Installation über Start»Programme»National Instruments» 
NI-DAQ»Browse Device Documentation geöffnet werden kann. 

Auf Ihrer Hardware können folgende Symbole aufgedruckt sein:

Mit diesem Symbol wird vor Datenverlust, Systemabsturz und Verlet- 
zungen gewarnt. Welche Vorsichtsmaßnahmen bei Produkten zu treffen 
sind, die mit diesem Symbol gekennzeichnet sind, wird im Faltblatt Read 
Me First: Safety and Radio-Frequency Interference in der Packungsbeilage 
erläutert.

Wenn ein Produkt mit diesem Symbol gekennzeichnet ist, besteht die 
Gefahr eines elektrischen Schlags.

Bei Produkten mit diesem Symbol kann eines der Bauteile heiß werden. 
Bei Berührung besteht Verletzungsgefahr.

Schritt 4: Anschließen der einzelnen Komponenten
Bauen Sie alle vorhandenen DAQ-Karten ein. Wenn Sie ein SCXI-Modul 
an Ihre DAQ-Karte anschließen möchten, installieren Sie zunächst die 
DAQ-Komponenten.

Vorsicht! Vor der Installation der Hardware ist unbedingt eine Erdung gemäß VDE erfor-
derlich. Alle weiteren wichtigen Informationen zu Sicherheitsbestimmungen und den 
Sicherheitsstandards, die Ihre Karte erfüllt, finden Sie auf dem mitgelieferten Datenblatt. 

Mit der Simulationsfunktion in NI-DAQmx können Sie NI-DAQmx- 
Applikationen auch ohne angeschlossene Hardware testen. Wie ein Gerät 
simuliert wird, erfahren Sie in der Hilfe zum Measurement & Automation 
Explorer für NI-DAQmx, die im MAX über Hilfe»Hilfethemen» 
NI-DAQmx geöffnet wird. 
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PCI- und PCI-Express-Karten
Folgende Schritte sind zur Installation einer PCI- oder PCI-Express-Karte 
durchzuführen:

1. Schalten Sie den Computer aus und ziehen Sie den Netzstecker.

2. Entfernen Sie das Computergehäuse und die Abdeckung für den 
Erweiterungssteckplatz.

3. Berühren Sie ein beliebiges Metallteil des Computers.

4. Führen Sie die Karte in den PCI- bzw. PCI-Express-Steckplatz ein und 
drücken Sie sie vollständig hinein. Wenden Sie dabei keine Gewalt an!

Abbildung 1.  Einbau einer PCI-Karte

Bei NI-PCI-Karten zur Datenerfassung werden die Daten über PCI- 
Busse wie PCI-X übertragen. Beachten Sie, dass PCI-Express-Karten 
nicht in PCI-Steckplätze passen und umgekehrt. PCI-Express-Karten 
können allerdings in einem PCI-Express-Steckplatz mit höherer Band-
breite eingebaut werden. Bei einigen Mainboards ist der x16-Steck- 
platz für die Grafikkarte reserviert. Wenn Sie den Steckplatz für eine 
andere Karte nutzen möchten, müssen Sie anhand der Herstellerhin-
weise eine andere Lösung für die Steuerung der Bildschirmanzeige 
finden. Einen Leitfaden zu PCI-Express finden Sie auf der Website 
ni.com/pciexpress.

5. Schrauben Sie die Metallschiene der Karte an der Rückwand des Com-
puters fest.

6. Montieren Sie das Computergehäuse.

1 PCI-DAQ-Karte 2 PCI-Steckplatz 3 PC mit PCI-Steckplatz

3

1
2
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PCMCIA-Karten
PCMCIA-Karten von National Instruments passen in alle PC-Kartensteck-
plätze des Typs II. Eine PCMCIA-Karte wird wie folgt eingesteckt:

1. Entfernen Sie die Abdeckung des PCMCIA-Steckplatzes (sofern 
vorhanden).

2. Führen Sie den Busanschluss des Geräts in den Steckplatz ein, bis 
dieser fest sitzt.

Abbildung 2.  Einbau einer PCMCIA-Karte in einen Laptop

3. Schließen Sie das Kabel an. Gehen Sie dabei vorsichtig vor. Beim Ein-
stecken und Herausziehen sollte immer der Stecker angefasst werden. 
Ziehen Sie auf keinen Fall direkt am Kabel!

PXI-Module
PXI-Module werden folgendermaßen eingebaut:

1. Schalten Sie das PXI-Gehäuse aus und ziehen Sie den Netzstecker.

Vorsicht! Lesen Sie vor dem Entfernen von Abdeckungen oder Kabeln das Faltblatt Read 
Me First: Safety and Radio-Frequency Interference in der Packungsbeilage des PXI-Chas-
sis oder -Moduls.

2. Entfernen Sie die Blende eines freien PXI-Steckplatzes. Manche 
Karten dürfen nur in bestimmten Steckplätzen betrieben werden. 

1 Computer mit PCMCIA-Steckplatz
2 PCMCIA-Steckplatz
3 PCMCIA-Karte

4 abgeschirmtes Kabel
5 Anschlussblock
6 Signalleitungen

®

®

DAQCard

1

2
3

4

5
6
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Nähere Informationen dazu finden Sie in der Dokumentation (siehe 
Installationsbeschreibung in Schritt 2: Installation von NI-DAQ 8.x).

3. Berühren Sie zur elektrostatischen Entladung ein beliebiges Metallteil 
des Gehäuses.

4. Stellen Sie sicher, dass der Arretierhebel des PXI-Moduls nicht einge-
rastet ist.

5. Schieben Sie das Modul in das Gehäuse ein.

6. Drücken Sie das Modul so weit in das Gehäuse, bis es die Steckerleiste 
berührt.

7. Wenn Sie einen Widerstand fühlen, ziehen Sie den Arretierhebel nach 
oben und drücken Sie die Karte vollständig in den Steckplatz.

8. Schrauben Sie die Frontplatte am Gehäuse fest.
 

Abbildung 3.  Einbau eines PXI-Moduls

USB-Geräte
National-Instruments-Geräte mit USB-Anschluss werden wie folgt 
angeschlossen:

1. Schließen Sie die Kabel für die Stromversorgung an.

• Wenn Sie mit einem BP-1-Akkupack arbeiten, schließen Sie 
dieses gemäß der Beschreibung an.

• Für einige Geräte von National Instruments mit USB-Anschluss 
ist eine separate Spannungsversorgung erforderlich.

1 PXI-Gehäuse
2 PXI-Controller
3 PXI-Modul
4 Arretierhebel

5 Befestigungsschrauben für die 
Frontplatte

6 Führungen für die Module
7 Netzschalter

3

1

2

4

PXI-1000B

7

5

6
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– Überprüfen Sie bei Geräten mit einem Netzteil zunächst, ob 
die Netzspannung (120 oder 230 V~) und die für das Gerät 
benötigte Spannung mit den Angaben auf dem Netzteil über-
einstimmen. Schließen Sie dann das Netzteil an.

– Wenn ein Netzkabel vorhanden ist, schließen Sie das Gerät 
damit an die Steckdose an.

2. Schließen Sie das Gerät an den USB-Anschluss des Computers oder 
einen USB-Verteiler an. 

3. Betätigen Sie nun den Netzschalter (sofern vorhanden). Das Gerät 
sollte automatisch vom Computer erkannt werden.

Zubehör
Der Anschluss von Zubehörteilen und Anschlussblöcken wird in der dazu-
gehörigen Anleitung beschrieben. Für SCXI- und SCC-Systeme folgen Sie 
bitte den Anweisungen bis Schritt 8: Installation von Signalkonditionie-
rungs- und Schaltmodulen.

Schritt 5: Einschalten des Computers bzw. PXI-Chassis
Nach einem Neustart des Computers wird neu angeschlossene Hardware in 
Windows automatisch erkannt. In manchen Windows-Versionen öffnet 
sich in diesem Fall das Dialogfeld “Neue Hardware gefunden”. Die Vor-
einstellung lautet: Software automatisch installieren (empfohlen). 
Klicken Sie auf Weiter bzw. Ja, um für jedes Gerät einen Treiber zu 
installieren.

Wenn ein Gerät mit USB-Anschluss erkannt wurde, leuchtet oder blinkt am 
Gerät eine LED. Die einzelnen Betriebszustände, die mit der LED signali-
siert werden, sind in der Beschreibung zum Gerät erklärt. 

Schritt 6: Überprüfung der automatischen Erkennung 
von Geräten

Gehen Sie nach folgenden Schritten vor:

1. Klicken Sie das Symbol Measurement & Automation auf dem Desk-
top doppelt an, um den MAX zu öffnen.

2. Erweitern Sie die Kategorie Geräte und Schnittstellen und anschlie-
ßend die Unterkategorie NI-DAQmx-Geräte. Bei Systemen im 
Netzwerk, die mit LabVIEW Real-Time arbeiten, klicken Sie zunächst 
die Kategorie Netzwerkumgebung, dann das System und anschlie-
ßend die Kategorie Geräte und Schnittstellen doppelt an. Die 
Konfiguration des traditionellen NI-DAQ-Treibers ist in der  
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Readme zum traditionellen NI-DAQ-Treiber beschrieben, die nach 
Installation des Treibers über Start»Programme»National Instru-
ments»NI-DAQ geöffnet wird.

3. Überprüfen Sie, ob das Gerät unter “Geräte und Schnittstellen” ange-
zeigt wird. Sollte eine Komponente nicht automatisch angezeigt 
werden, muss die Anzeige unter Umständen mit der <F5>-Taste aktua-
lisiert werden. Wenn das Gerät dann immer noch nicht erscheint, 
besuchen Sie die Website ni.com/support/install.

4. Klicken Sie mit der rechten Maustaste auf das Gerät und wählen Sie 
Selbsttest.

 

1 Falls ein Gerät sowohl mit NI-DAQmx als auch mit dem traditionellen NI-DAQ- 
Treiber arbeitet und beide Treiber installiert sind, wird das Gerät unter Mein 
System»Geräte und Schnittstellen mit unterschiedlichen Namen in beiden 
Kategorien aufgeführt. 

2 Beachten Sie, dass unter Netzwerkumgebung»Geräte und Schnittstellen nur 
die NI-DAQmx-Geräte angezeigt werden. 

1

2
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Bei Problemen mit dem Selbsttest des Geräts lesen Sie die MAX-Hilfe 
für NI-DAQmx, die sich unter Hilfe»Hilfethemen»NI-DAQmx befin-
det. Nach Abschluss des Selbsttests erscheint eine Meldung darüber, 
ob ein Fehler festgestellt wurde. Unterstützung bei der Fehlersuche 
erhalten Sie auf unserer Website ni.com/support/install.

Mit der Simulationsfunktion in NI-DAQmx können Sie NI-DAQmx- 
Applikationen auch ohne angeschlossene Hardware testen. Lesen Sie 
dazu auch die Hilfe zum Measurement & Automation Explorer für 
NI-DAQmx, die im MAX über Hilfe»Hilfethemen»NI-DAQmx 
geöffnet wird. 

Schritt 7: Konfiguration der Geräteeinstellungen
Konfigurieren Sie alle angeschlossenen Geräte wie nachfolgend 
beschrieben:

1. Klicken Sie mit der rechten Maustaste auf den Namen des Geräts und 
wählen Sie Eigenschaften. Vergewissern Sie sich, dass Sie das Gerät 
unter der richtigen Kategorie (“Mein System” oder “Netzwerkumge-
bung”) und der richtigen NI-DAQ-API ausgewählt haben. 

2. Nehmen Sie die gewünschten Einstellungen vor. Bei Komponenten, 
die sowohl mit NI-DAQmx als auch mit dem traditionellen NI-DAQ- 
Treiber arbeiten sollen, müssen beide Treiber konfiguriert werden.

• Zusätzliche Bauteile können unter Zubehör angegeben werden.

• Dem Standard IEEE 1451.4 entsprechende Sensoren, deren tech-
nische Daten in einem speziellen integrierten Speicher enthalten 
sind (Transducer Electronic Data Sheet, elektronisches Datenblatt 
zum Sensor) – so genannte TEDS-Sensoren – sind zunächst zu 
konfigurieren, bevor entsprechende Zubehörteile hinzugefügt 
werden können. Wählen Sie Nach TEDS suchen. Zur Konfigura-
tion von TEDS-Sensoren, die direkt an ein Gerät angeschlossen 
sind, klicken Sie das entsprechende Gerät im MAX unter “Geräte 
und Schnittstellen” mit der rechten Maustaste an und wählen Sie 
TEDS konfigurieren.

3. Klicken Sie zum Speichern der Änderungen auf OK.
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Schritt 8: Installation von Signalkonditionierungs- und 
Schaltmodulen

Wenn Ihr Mess-System SCXI-Signalkonditionierungsmodule, Signalkon-
ditionierungskomponenten (wie SCC-Modulträger oder SCC-Module), 
Anschlussblöcke oder Schaltmodule enthält, lesen Sie zur Installation und 
Konfiguration den Getting Started Guide zum verwendeten Produkt.

Die nachfolgenden Anweisungen gelten nur für DAQ-Karten und 
PXI-Karten mit integrierter Signalkonditionierung.

Schritt 9: Anschließen der Sensoren und 
Signalleitungen

Schließen Sie die Sensoren bzw. Signalquellen an den Anschlussblock oder 
andere Zubehörteile an. 

Im DAQ-Assistenten ist zu den NI-DAQmx-Tasks und virtuellen Kanälen 
auf Ihrem System ein Anschlussplan enthalten, der auch ausgedruckt 
werden kann. Wählen Sie dazu den Task oder virtuellen Kanal aus und 
klicken Sie auf die Registerkarte Anschlussplan. Um zu sehen, wie der 
Sensor im Einzelnen mit dem Anschlussblock zu verbinden ist, klicken Sie 
die einzelnen virtuellen Kanäle im Task an. 

Die Dokumentation, die mit dem Device Document Browser aufgerufen 
werden kann, enthält auch Pinbelegungen. Zur Anzeige des entsprechen-
den Abschnitts in der Hilfe klicken Sie nach der Installation des Device 
Document Browser auf Start»Programme»National Instruments» 
NI-DAQ»Browse Device Documentation und suchen in der Hilfe zum 
Measurement & Automation Explorer für NI-DAQmx nach Device 
Terminals.

Weitere Informationen zu Sensoren finden Sie auf der Website ni.com/ 
sensors oder im Abschnitt Sensors der Datei NI-DAQmx Help 
(Start»Programme»National Instruments»NI-DAQ» 
NI-DAQmx Help). TEDS-Sensoren (intelligente Sensoren, die dem Stan-
dard IEEE 1451.4 entsprechen) sind auf ni.com/zone beschrieben. 

In den Beschreibungen der Schaltmodule finden Sie auch Angaben zur 
Gerätearchitektur.
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Schritt 10: Starten des Testpanels
Bei vielen Geräten sind Testläufe zur Überprüfung bestimmter Funktionen 
möglich, beispielsweise der Erfassung oder Ausgabe von Signalen. Ein 
Testpanel wird folgendermaßen gestartet: 

1. Erweitern Sie im MAX die Kategorie Geräte und Schnittstellen» 
NI-DAQmx-Geräte. Bei RT-Systemen im Netzwerk klicken Sie 
zunächst die Kategorie Netzwerkumgebung, dann das System und 
anschließend die Kategorie Geräte und Schnittstellen doppelt an.

2. Klicken Sie mit der rechten Maustaste auf den Namen der 
Komponente. 

3. Wählen Sie anschließend die Option Testpanels aus, um das ausge-
wählte Gerät zu überprüfen. Es öffnet sich ein Dialogfeld (vgl. 
Abbildung).

4. Klicken Sie zur Überprüfung der einzelnen Funktionen des Geräts auf 
die verschiedenen Registerkarten. Hilfestellung bei der Handhabung 
der Testpanels erhalten Sie im Menü unter Hilfe.

5. Wenn ein Fehler vorliegt, wird im Testpanel eine entsprechende Mel-
dung ausgegeben. Für Hilfe in diesem Fall stehen Ihnen die Datei 
NI-DAQmx Reference Help und die Website ni.com/support zur 
Verfügung. 
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6. Klicken Sie zum Verlassen des Testpanels auf Schließen.

Wenn Sie in Ihren Rechner mehrere DAQ-Karten eingebaut haben, müssen 
Sie Schritt 7: Konfiguration der Geräteeinstellungen bis Schritt 10: Starten 
des Testpanels für jede Karte wiederholen. 

Schritt 11: Konfiguration der Kanäle und Tasks
Dieser Schritt ist nur dann erforderlich, wenn Sie Ihre Karte mit 
NI-DAQmx oder einer Entwicklungsumgebung von National Instruments 
programmieren. 

Ein Task – ein wichtiger neuer Bestandteil von NI-DAQmx – ist ein  
Messprojekt. Dazu gehört mindestens ein virtueller Kanal, zu dem es eine 
Vielzahl von Einstellungen gibt, wie Taktrate oder Triggerzeitpunkt. In 
einem Task sind also alle Parameter einer Messung oder Signalerzeugung 
zusammengefasst. Die Einstellungen eines Tasks sind veränderbar und 
lassen sich speichern, so dass dieser auch in anderen Applikationen ver-
wendet werden kann.

In NI-DAQmx können virtuelle Kanäle als Teil eines Tasks oder separat 
konfiguriert werden. Virtuelle Kanäle, die innerhalb eines Tasks erstellt 
wurden, werden als lokale virtuelle Kanäle bezeichnet, und solche, die 
separat erstellt wurden, als globale virtuelle Kanäle. Globale virtuelle 
Kanäle sind an keine Applikation gebunden und können somit beliebig 
weiterverwendet werden. Die Erstellung eines globalen Kanals ist entwe-
der im MAX oder in einer Entwicklungsumgebung von National 
Instruments möglich. Änderungen an einem globalen Kanal werden auto-
matisch für alle Tasks übernommen, in denen der Kanal verwendet wird. 

Konfiguration eines Tasks in NI-DAQmx
Tasks für NI-DAQmx werden mit Hilfe des DAQ-Assistenten konfiguriert. 
Zum Erstellen von Tasks und Kanälen mit dem DAQ-Assistenten muss 
eine Entwicklungsumgebung von National Instruments ab Version 7.0 
installiert sein.

• Klicken Sie im MAX mit der rechten Maustaste auf Datenumgebung 
und wählen Sie Neu. Wählen Sie NI-DAQmx-Task und klicken Sie 
auf Weiter. Bei RT-Systemen erweitern Sie zunächst die Kategorie 
Netzwerkumgebung und klicken dann das System doppelt an, um zur 
Kategorie Datenumgebung zu gelangen.
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• Der DAQ-Assistent lässt sich auch von der Entwicklungsumgebung 
aus öffnen.

– Fügen Sie dazu in LabVIEW entsprechend der Beschreibung 
unter Erste Schritte mit LabVIEW das Express-VI “DAQ- 
Assistent”, das sich auf der Express-Palette “Eingabe” befindet, in 
das Blockdiagramm ein.

Sie können den DAQ-Assistenten auch öffnen, indem Sie aus der 
Palette “DAQmx-Namenselemente” ein Bedienelement des Typs 
“DAQmx-Taskname” in das Frontpanel einfügen, das Element 
mit der rechten Maustaste anklicken und Neuer Task 
(DAQ-Assistent) auswählen. Alle Schritte zum Erstellen eines 
Tasks einschließlich der Erzeugung von Blockdiagrammcode 
sind in der Hilfedatei Messungen mit NI-DAQmx in LabVIEW 
beschrieben, die in LabVIEW über Hilfe»Messungen mit 
NI-DAQmx in LabVIEW geöffnet wird.

– In LabWindows/CVI:

1. Wählen Sie Tools»Create/Edit DAQmx Tasks. Es öffnet 
sich das Dialogfeld “Create/Edit DAQmx Tasks”. 

2. Wählen Sie Create New Task In MAX oder Create New 
Task In Project und klicken Sie auf OK.

– In Measurement Studio:

1. Öffnen Sie Visual Studio .NET und das Projekt, in dem der 
DAQmx-Task erzeugt werden soll.

2. Wählen Sie Project»Add New Item. Daraufhin öffnet sich 
das Dialogfeld “Add New Item”. 

3. Klicken Sie unter “Categories” auf Measurement Studio» 
Assistent.

4. Wählen Sie anschließend aus den Vorlagen DAQmx Task 
Class aus.

5. Geben Sie für die Datei zum DAQmx-Task einen Namen an 
und klicken Sie auf Open. 

6. Geben Sie an, ob Sie einen neuen Task oder eine Kopie eines 
globalen Tasks erstellen möchten, der im MAX erzeugt 
wurde, und klicken Sie auf Beenden.

Der DAQ-Assistent fordert Sie zum Erstellen eines neuen Tasks auf. Es ist 
anzugeben, ob der Task zur Erfassung oder Ausgabe von Analog- oder 
Digitalsignalen dienen soll, ob ein Sensor verwendet wird und aus welchen 
physikalischen Kanälen lokale virtuelle Kanäle erzeugt werden sollen. 
Wenn Sie bereits globale virtuelle Kanäle für die gewünschte Art der Mes-
sung konfiguriert haben, klicken Sie auf die Registerkarte Virtuell, um 
dem Task globale virtuelle Kanäle hinzufügen oder Kanäle in den Task 
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hinein zu kopieren. Wie ein Task genau erstellt wird, kann in der Hilfe zum 
DAQ-Assistenten nachgelesen werden.

Konfiguration globaler virtueller Kanäle in NI-DAQmx
Wenn Sie virtuelle Kanäle in mehreren NI-DAQmx-Tasks oder -Applika-
tionen verwenden möchten, konfigurieren Sie mit Hilfe des DAQ- 
Assistenten globale virtuelle Kanäle. Mit dem DAQ-Assistenten können 
im MAX oder in LabVIEW globale virtuelle Kanäle konfiguriert werden.

• Um den DAQ-Assistenten im MAX zu öffnen, klicken Sie mit der 
rechten Maustaste auf Datenumgebung und wählen Sie Neu. Klicken 
Sie im Fenster “Hinzufügen” auf Globaler NI-DAQmx-Kanal und 
anschließend auf Weiter. 

• Um den DAQ-Assistenten direkt von LabVIEW aus zu öffnen und 
damit einen globalen virtuellen Kanal zu erstellen, fügen Sie ein 
Bedienelement des Typs DAQmx - Globaler Kanal in das Frontpanel 
ein, klicken es mit der rechten Maustaste an und wählen Neuer 
DAQmx-Kanal.

Der DAQ-Assistent fordert Sie dann zur Erstellung eines neuen globalen 
virtuellen Kanals auf. Es ist anzugeben, ob der Kanal zur Erfassung oder 
Ausgabe von Analog- oder Digitalsignalen dienen soll, ob ein Sensor ver-
wendet wird und aus welchem physikalischen Kanal ein globaler virtueller 
Kanal erzeugt werden soll. Wie Tasks und virtuelle Kanäle genau erstellt 
und in einer Applikation genutzt werden, kann in der Hilfe zum DAQ-Assi-
stenten nachgelesen werden.

In LabWindows/CVI und Measurement Studio können Sie globale virtu-
elle Kanäle nicht direkt erstellen, sondern müssen sie, wie zuvor 
beschrieben, im MAX erzeugen.

Von der Entwicklungsumgebung aus können Sie auch einen vorhandenen 
globalen virtuellen Kanal zu einem Task hinzufügen oder in den Task 
kopieren.

1. Starten Sie den DAQ-Assistenten wie in Konfiguration eines Tasks in 
NI-DAQmx beschrieben. 

2. Klicken Sie auf die Schaltfläche zum Hinzufügen von Kanälen ( ). 

3. Wählen Sie auf der Registerkarte “Virtuell” im Dialogfeld “Kanäle zu 
Task hinzufügen” einen globalen virtuellen Kanal aus, der kopiert oder 
hinzugefügt werden soll. 
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Schritt 12: Verwenden des Geräts in einer Applikation

DAQ-Assistent
Mit Hilfe der folgenden Schritte binden Sie einen Mess-Task in Ihre Appli-
kation ein oder erzeugen aus dem Task ein Programm. Nähere Einzelheiten 
dazu finden Sie in der DAQ Assistant Help.

LabVIEW
1. Öffnen Sie ein leeres VI. 

2. Fügen Sie die folgende Konstante in das Blockdiagramm ein:  
NI-Messtechnik»DAQmx - Datenerfassung»DAQmx - Taskname 
(Konstante).

3. Wählen Sie aus dem Pulldown-Menü einen Task aus. 

4. Klicken Sie das VI mit der rechten Maustaste an und wählen Sie  
Programmcode erzeugen»Beispiel. 

5. Wechseln Sie zum Frontpanel und starten Sie das VI.

LabWindows/CVI
Eine detaillierte Anleitung zur Verwendung von Tasks in  
LabWindows/CVI erhalten auf ni.com/info nach Eingabe von rddq73.

Measurement Studio
Für eine detaillierte Anleitung zur Verwendung von Tasks in Measurement 
Studio geben Sie auf der Website ni.com/info die Buchstabenkombina-
tion rddqms ein.
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Beispiele
Anhand von Beispielen können Sie eine neue Applikation erstellen oder 
eine bestehende Applikation erweitern.

Zusätzliche Beispiele sind unter ni.com/zone zu finden.

Mit der NI-DAQmx-Simulationsfunktion lassen sich Beispiele auch aus-
führen, ohne dass die benötigten Geräte angeschlossen sind. Wie ein Gerät 
simuliert wird, ist in der Hilfe zum Measurement & Automation Explorer 
für NI-DAQmx nachzulesen, die im MAX über Hilfe»Hilfethemen» 
NI-DAQmx geöffnet wird. 

VI Logger Lite
Auf der NI-DAQmx-CD befindet sich auch VI Logger Lite, ein einfach zu 
nutzendes Werkzeug, das speziell für Applikationen zur Datenprotokollie-
rung vorgesehen ist. Zum Öffnen des Programms wählen Sie Start» 
Programme»National Instruments»VI Logger. Die Datei VI Logger 
Help befindet sich im MAX unter Hilfe»Hilfethemen»VI Logger.

Weitere Informationen
Nach der Installation der Dokumentation lässt sich diese über Start» 
Programme»National Instruments»NI-DAQ»Browse Device  
Documentation aufrufen. Die Beschreibungen zu NI-DAQ, wie die 
NI-DAQmx Help oder die vorliegende Anleitung Erste Schritte mit 
NI-DAQ (als PDF-Datei), können über Start»Programme» 
National Instruments»NI-DAQ»NI-DAQmx Titel des Dokuments 
geöffnet werden.

Anwendung Speicherort (Beispiel)

LabVIEW oder LabWindows/CVI Hilfe»Beispiele suchen

Programmiersprachen, die von 
Measurement Studio unterstützt werden

MFC C++

Beispiele zu Visual Basic .NET und C#*

MeasurementStudioVS2003\VCNET\Examples\
DAQmx

MeasurementStudioVS2003\DotNET\ 

Examples\DAQmx

ANSI C NI-DAQ\Examples\DAQmx ANSI C

* Measurement Studio nicht erforderlich
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Fehlersuche
Nachfolgend sind einige Informationsquellen aufgeführt, die Ihnen bei 
Problemen mit der Installation Ihrer Hard- oder Software zur Datenerfas-
sung von Nutzen sein können:

• Bei Problemen besuchen Sie bitte unsere Website ni.com/ 
support/install und gehen Sie nach den Anweisungen im  
Hardware Installation/Configuration Troubleshooter vor.

• Auf ni.com/kb finden Sie häufig gestellte Fragen und Hilfe zu Pro-
blemen bei der Installation oder Programmierung.

• Falls Sie ein Gerät aufgrund einer Beschädigung zur Reparatur oder 
Kalibrierung an National Instruments zurücksenden müssen, besuchen 
Sie bitte unsere Website ni.com/support und geben die Buchsta-
benkombination rdsenn ein. Hier erfahren Sie, was bei der Waren- 
rücksendung an National Instruments zu beachten ist.

Weltweite technische Unterstützung
Weitere Unterstützung finden Sie auf der Website ni.com/support oder 
ni.com/zone. Weitere Informationen zu Signalkonditionierungsgeräten 
finden Sie im Dokument Signal Conditioning Technical Support Informa-
tion in der Packungsbeilage des Geräts.

Bei Anfragen wenden Sie sich bitte an eine Niederlassung von National 
Instruments. Die Adresse der Hauptgeschäftsstelle von National Instru-
ments in den USA lautet: 11500 North Mopac Expressway, Austin, Texas, 
78759-3504.



DAQスタートアップガイド
この文書では、NI-DAQmx 8.xドライバソフトウェアおよびデータ集録
（DAQ）デバイスのインストール、構成方法、およびデバイスが適切に動
作しているかどうかを確認する方法について説明します。 従来型 NI-DAQ
（レガシー）の構成方法については、『従来型 NI-DAQ（レガシー）
Readme』を参照してください。この Readmeは、ソフトウェアのイ
ンストール後にスタート→プログラム→ National Instruments→
NI-DAQを選択して表示できます。

NI-DAQソフトウェア
ナショナルインスツルメンツの計測デバイスには、NI-DAQドライバソフ
トウェアが添付されています。これは、LabVIEWや
LabWindowsTM/CVITMなどのアプリケーションソフトウェアから呼び出

すことができる VIと ANSI C関数を多数含むライブラリで、NI計測器
（Mシリーズマルチファンクション I/O（MIO）DAQデバイス、信号調
節モジュール、スイッチモジュールなど）のプログラムに使用できます。 
また、ドライバソフトウェアには、デバイスのアプリケーションを作成す

るための、VI、関数、クラス、属性、およびプロパティのライブラリであ
るアプリケーションプログラミングインタフェース（API ）が含まれてい
ます。

NI-DAQ 7.x以上には、NI-DAQドライバが 2つ含まれており、それぞれ
のドライバには独自の API、ハードウェア構成、およびソフトウェア構成
があります。 NI-DAQmxは最新の NI-DAQドライバで、従来型 NI-DAQ
（レガシー）に比べ、以下の優位点があります。

� DAQアシスタント : LabVIEW、LabWindows/CVI、および
Measurement Studio、VI Loggerで使用できるように、デバイス
の仮想チャンネルおよび計測タスクを構成し、この仮想チャンネルと

タスクに基づいて NI-DAQmxコードを生成するグラフィカルツー
ル。

� 高速化シングルポイントアナログ I/Oやマルチスレッドなどによる
パフォーマンスの向上。

� ハードウェアを接続することなく実行できる、サポート対象デバイス

のテストやアプリケーション変更の NI-DAQmxシミュレーション。
NI-DAQmxでサポートされていても NI-DAQmxでのシミュレーショ
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ン機能を持たないデバイスもあります。それらのデバイスの一覧は

『NI-DAQ Readme』に記載されています。

� シンプルで直感的な APIによる、旧バージョンより少ない関数と VI
での DAQアプリケーション作成。

従来型 NI-DAQ（レガシー）は、ナショナルインスツルメンツの古い
DAQデバイスのデータ集録、計測、制御のアプリケーションを開発する
旧式の API とともに使用する古いドライバです。 したがって、特定の環境
のみで従来型 NI-DAQ（レガシー）を使用してください。 従来型 NI-DAQ
（レガシー）を使用しなければならない特定の条件（サポートされるデバ

イス、オペレーティングシステム、アプリケーションソフトウェア、多言

語バージョンの一覧など）については、『NI-DAQ Readme』を参照して
ください。 

手順 1. ソフトウェアをインストールする
NIアプリケーションソフトウェアをインストールします。 NI-DAQmxを
使用するには、LabVIEW 7.x以上、LabWindows/CVI 7.x以上、
Measurement Studio 7.x以上、 VI Logger 2.x、LabVIEW Real-Timeモ
ジュール 7.1以上のいずれかをインストールしてください。

旧バージョンのアプリケーション開発環境または NI-DAQで作成された
アプリケーションが存在する場合は、そのアプリケーションのバックアッ

プコピーを作成します。 その後、ソフトウェアをアップグレードして、そ
のアプリケーションを修正することができます。

手順 2. NI-DAQ 8.xをインストールする
新規ハードウェアデバイスをインストールする前 にドライバソフトウェ

アをインストールして、Windowsがデバイスを検出できるようにしてく
ださい。 既存のアプリケーションに、サポートされていないコンポーネン
ト（『NI-DAQ Readme』の一覧を参照）が含まれている場合は、
NI-DAQ 8.xをインストールしないでください。
1. CDを挿入します。 NI-DAQ 8.xのインストーラが自動的に起動しま
す。 インストーラが起動しない場合は、スタート→ファイル名を指定
して実行を選択してください。 x:¥autorun.exeと入力します。ここ
で、xはCDドライブの文字を示します。 トラブルシューティングの
説明については、ni.com/support/ja/troubleshootingのトラ

ブルシューティングリソースを参照してください。

2. ソフトウェアをインストールします。 

� ～をインストールをクリックすると、ソフトウェアおよび /また
は文書ファイルがハードディスクにコピーされます。 NI-DAQソ
フトウェアのマニュアルは、ドライバソフトウェアと同時にイン

ストールされます。 
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� ～を表示をクリックすると、文書をインストールしないで開き、

内容を検索、表示、印刷できます。 

注意 NI-DAQ 7.x以上は、NI-DAQ 7.0以前のバージョンと同じシステムに共存させる
ことができません。

3. サポートファイルをインストールします。 NI-DAQ 7.xインストーラ
はシステムにインストールされている NIソフトウェアを検出し、最
新のドライバ、アプリケーションソフトウェア、および言語サポート

ファイルをCDから自動的にインストールします。 インストーラに
よって正しいサポートファイルとバージョンが検出され、選択されて

いることを確認してください。

NIアプリケーションソフトウェア 7.x以上をインストールする前に
NI-DAQをインストールする場合、NI-DAQインストーラを再度実行
して正しいアプリケーションソフトウェアサポートファイルをインス

トールする必要があります。

4. 次へをクリックします。

5. 終了をクリックします。

6. NI-DAQのインストールが完了すると、再起動、シャットダウン、終
了のいずれかを選択できる画面が表示されます。

� 他の NIソフトウェアまたは文書をインストールするには、終了
をインストールします。 

� サポートされているデバイスおよびアクセサリのオンライン

文書（デバイスの端子、仕様、機能、および操作を説明した

PDFおよびヘルプファイル等）をインストールできます。 
NI-DAQの CDを再度挿入して、インストーラ画面を再び表
示します。 デバイス文書をインストールを選択します。 

� PCから PXIシャーシを制御するためにMXI-3を使用してい
る場合は、DAQデバイスを使用する前に終了し、ni.com/ 
jp/downloadsから入手できるMXI-3ソフトウェアをイン
ストールしてください。

� デバイスをインストールする準備ができたら、シャットダウンを

選択します。

� LabVIEW Real-Timeモジュールを実行しているシステムを使用
している場合は、再起動を選択します。 Measurement & 
Automation Explorer（MAX）を使用して、ターゲットに
NI-DAQ 8.xをダウンロードします。 ヘルプ→ヘルプトピック→
リモートシステムを選択し、『Measurement & Automation 
Explorer リモートシステムヘルプ』を参照してください。
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手順 3. デバイス、アクセサリ、およびケーブルの梱包
を解く

デバイスを箱から取り出し、部品がゆるんでいないかどうか、また、損傷

箇所がないかどうか調べてください。 デバイスが損傷している場合は、ナ
ショナルインスツルメンツまでご連絡ください。 損傷したデバイスはイン
ストールしないでください。

安全およびコンプライアンスに関する情報は、各デバイスのマニュアルに

記載されています。ni.com/support/ja/manualsにアクセスするか、

製品をインストール済みの場合はスタート→プログラム→ National 
Instruments→ NI-DAQ→ Browse Device Documentationを選択し
てください。 

デバイスでは、たとえば次のような記号が使用されていることがあります。

このアイコンは、負傷、データの損失、システムの破壊を防止するための

注意事項を示します。 デバイスにこの記号が付いている場合には、デバイ
スに同梱されている『Read Me First: Safety and Radio-Frequency 
Interference』（英語）を参照してください。

製品にこの記号が付いている場合は、電気ショックを防止するための事前

対策についての警告を示します。

製品にこの記号が付いている場合は、熱を帯びる可能性があるコンポーネ

ントを表します。 このコンポーネントに接触すると、負傷するおそれがあ
ります。

手順 4. デバイス、アクセサリ、およびケーブルを取り
付ける

複数の DAQデバイスをインストールする場合は、この段階ですべてイン
ストールします。 DAQデバイスに SCXIモジュールを接続する場合は、
まず DAQコンポーネントをインストールしてください。

注意 適切な静電破壊防止対策により身体が接地されていることを必ず確認してから、

ハードウェアをインストールしてください。 安全とコンプライアンスに関する情
報については、デバイスの仕様書を参照してください。 

NI-DAQmxシミュレーションデバイスを使用すると、ハードウェアをイ
ンストールせずに NI-DAQmxアプリケーションをテストすることができ
ます。 シミュレーションデバイスの作成方法については、ヘルプ→ 

ヘルプトピック→ NI-DAQmxを選択して、『NI-DAQmx対応
Measurement & Automation Explorerヘルプ』を参照してください。 
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PCIおよび PCI Expressデバイス
PCIまたは PCI Expressデバイスをインストールするには、以下の手順に
従ってください。

1. コンピュータの電源を切り、コードを抜いてください。

2. コンピュータおよび /または拡張スロットのカバーを外します。

3. 静電気を放電するため、コンピュータの金属部分に接触します。

4. 適切な PCIまたは PCI Expressシステムスロットにデバイスを挿入
します。 そっと揺り動かしながら、デバイスをスロットに差し込みま
す。 デバイスをスロットへ無理に押し込まないでください。

図 1 PCIデバイスをインストールする

PCI標準により、ユニバーサル PCIコネクタ付きの NI PCI DAQデ
バイスは、PCI-Xを含む PCI準拠のバスでサポートされています。
PCIスロットに PCI Expressデバイスをインストールする（または
PCI Expressスロットに PCIデバイスをインストールする）ことはで
きません。 PCI Expressデバイスは、より高いレーン幅の PCI 
Expressスロットにアッププラグすることをサポートしています。 一
部のマザーボードでは、グラフィック使用の x16スロットを予約し
ます。非グラフィックデバイスに x16を使用する場合は、代替のグ
ラフィック解決策について、コンピュータ製造元の説明書を参照して

ください。 PCI Expressのガイドラインについては、
ni.com/pciexpress（英語）を参照してください。

5. デバイスの取り付け金具をコンピュータのバックパネルレールに取り

付けます。

6. 該当する場合、コンピュータのカバーを元の位置に戻します。

1 PCI DAQデバイス 2 PCIシステムスロット 3 PCIスロットがある PC

3

1
2
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PCMCIAデバイス
NI PCMCIAデバイスは、Type IIの PCカードの空きスロットにインス
トールできます。 次の手順に従ってください。

1. コンピュータの PCMCIAスロットカバーを外します（該当する場合）。

2. コネクタがしっかりと接続されるまで、PCMCIAデバイスの
PCMCIAバスコネクタをスロットに挿入します。

図 2 ラップトップコンピュータに PCMCIAデバイスをインストールする

3. I/Oケーブルを取り付けます。 ケーブルコネクタの挿入や取り外しで
は、I/Oケーブルに負担をかけないように注意してください。 常に、
挿入または取り外しを行うケーブルのコネクタ部分をしっかりとつか

んでください。 PCMCIAデバイスから I/Oケーブルを絶対に直接引
き抜かないでください。

PXIデバイス
PXIモジュールをインストールするには、以下の手順に従ってください。

1. PXIシャーシの電源を切り、コードを抜いてください。

注意 機材のカバーの取り外し、または信号配線を接続または接続解除する前に、PXI
または SCXIシャーシまたはデバイスに添付されている『Read Me First: Safety 
and Radio-Frequency Interference』（英語）を参照してください。

1 PCMCIAスロットがあるコンピュータ
2 PCMCIAソケット
3 PCMCIAデバイス

4 シールドされた I/Oケーブル
5 アクセサリ

6 信号線

®

®

DAQCard

1

2
3

4

5
6
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2. 未使用の PXIスロットのカバーパネルを外します。 スロットの要件に
ついては、「手順 2. NI-DAQ 8.xをインストールする」に記述されて
いるデバイス文書を参照してください。

3. 静電気を放電するため、シャーシの金属部分に触れます。

4. PXIモジュールの脱着ハンドルが固定されないで自由に揺れ動く状態
にします。

5. PXIモジュールの縁をシャーシの上下にあるモジュールガイドに配置
します。

6. デバイスを PXIスロットに差し込みシャーシ背面に向かってスライド
させます。

7. 抵抗を感じたら、脱着ハンドルを引き上げてデバイスを完全に挿入し

ます。

8. シャーシのフロントパネル取り付けレールに、デバイスのフロントパ

ネルをネジで取り付けます。
 

図 3 PXIデバイスをインストールする

USBデバイス
USB対応の NIデバイスをインストールするには、以下の手順に従ってく
ださい。

1. 電源を接続します。

� BP-1バッテリーパックを使用している場合は、BP-1のインス
トールガイドにある手順に従ってください。

1 PXIシャーシ
2 PXIシステムコントローラ
3 PXIモジュール
4 脱着ハンドル

5 フロントパネル取り付けネジ

6 モジュールガイド

7 電源スイッチ

3

1

2

4

PXI-1000B

7

5

6
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� USB対応の NIデバイスの中には外部電源が必要なデバイスもあ
ります。

� デバイスが外部電源を使用するタイプの場合、外部電源 

（ある場合）の電圧が、デバイスを使用する地域の電圧

（120/230 VAC）とデバイスが必要とする電圧に合っている
か確認してください。 電源の片方をコンセントに接続し、 
もう片方をデバイスに取り付けます。

� デバイスに電源コードがある場合は、電源コードの片方をデ

バイスに接続し、もう片方をコンセントに接続します。

2. コンピュータの USBポートまたはその他のハブから、デバイスの使
用可能な USBポートへケーブルを接続します。 

3. USBデバイスに電源スイッチがある場合、デバイスの電源を入れま
す。 コンピュータがデバイスを即座に検出します。

アクセサリ
インストールガイドの手順に従って、アクセサリやターミナルブロックを

取り付けます。 SCXIおよび SCC信号調節システムについては、この文書
の「手順 8. 信号調節またはスイッチデバイスをインストールする」セク
ションまでの手順に従ってください。

手順 5. コンピュータまたは PXIシャーシに電源を入れる
Windowsは、ハードウェアのインストール後に初めてコンピュータが再
起動されたときに、新しくインストールされたデバイスを認識します。 一
部のWindowsシステムでは、インストールされたすべての NIデバイス
に対して、新しいハードウェアの検索ウィザードが起動します。 デフォル
トでは、デバイスに最適なドライバを検索する（推奨）が選択されていま

す。 次へまたははいをクリックして、各デバイスのソフトウェアをインス
トールします。

コンピュータが USBを認識すると、デバイスにある電源の LEDが点滅ま
たは点灯します。 LEDの点滅パターンおよびトラブルシューティングにつ
いては、各デバイスのマニュアルを参照してください。 

手順 6. デバイスが認識されたことを確認する
以下の手順に従ってください。

1. デスクトップにあるMeasurement & Automationアイコンをダブ
ルクリックして、MAXを開きます。
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2. デバイスとインタフェース→ NI-DAQmxデバイスを展開します。 リ
モート RTターゲットを使用する場合、リモートシステムを展開し、
ターゲットを展開し、デバイスとインタフェースを展開します。 従来
の NI-DAQ（レガシー）の構成方法については、『従来型 NI-DAQ
（レガシー）Readme』を参照してください。この Readmeは、ソ
フトウェアのインストール後にスタート→プログラム→ National 
Instruments→ NI-DAQを選択して表示できます。

3. デバイスとインタフェースの下にデバイスが表示されるか確認しま

す。 デバイスが表示されない場合には、<F5>を押してMAXの表示
を更新します。それでもデバイスが認識されないときは、ni.com/ 
support/ja/troubleshootingを参照してください。

4. デバイスを右クリックして、セルフテストを選択します。
 

1 1つのデバイスが NI-DAQmxと従来型 NI-DAQ（レガシー）の両方でサポートされてい
て、その両方がインストールされている場合、マイシステム→デバイスとインタフェー
スの下に同じデバイスが異なる名前で表示されます。 

2 リモートシステム→デバイスとインタフェースの下には NI-DAQmxデバイスのみが表示
されます。 

1

2
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セルフテスト中にヘルプの参照が必要な場合、ヘルプ→ヘルプトピッ

ク→ NI-DAQmxを選択して『NI-DAQmx対応MAXヘルプ』を開
きます。 セルフテストが終了すると、テストが成功した確認またはエ
ラーが発生したかどうかを示すメッセージが表示されます。 エラーが
発生した場合、トラブルシューティングに関する情報については、

ni.com/support/install（英語）を参照してください。

NI-DAQmxシミュレーションデバイスを使用すると、ハードウェア
をインストールせずに NI-DAQmxアプリケーションをテストするこ
とができます。 シミュレートしたデバイスを作成し、シミュレートし
たデバイスの構成を物理デバイスにインポートする手順については、

ヘルプ→ヘルプトピック→ NI-DAQmxを選択して、『NI-DAQmx対
応Measurement & Automation Explorerヘルプ』を参照してくだ
さい。 

手順 7. デバイスを設定する
インストールする各デバイスを構成します。

1. デバイス名を右クリックしてプロパティを選択します。 システム（マ
イシステムまたはリモートシステム）の下位にあるデバイス名と、デ

バイスの制御に使用する NI-DAQ APIをクリックします。 

2. デバイスのプロパティを構成します。 NI-DAQmxと従来型 NI-DAQ
（レガシー）の両方でデバイスを使用するには、それぞれの APIでデ
バイスを設定する必要があります。

� アクセサリを使用している場合、アクセサリについての情報を追

加します。

� IEEE 1451.4 トランスデューサ電子データシート（TEDS）センサ
およびアクセサリについては、上記の方法でデバイスを構成して

アクセサリを追加します。 TEDSをスキャンをクリックします。 
MAXでデバイスに直接接続された TEDSセンサを構成するには、
デバイスとインタフェースの下にあるデバイスを右クリックし

て、TEDSを構成を選択します。

3. OKをクリックして変更を承諾します。

手順 8. 信号調節またはスイッチデバイスをインストー
ルする

システムで SCXI信号調整モジュール、SCキャリアや SCCモジュールな
どの信号調節コンポーネント（SCC）、ターミナルブロック、スイッチモ
ジュールが使用されている場合は、各製品のスタートアップガイドを参照

して信号調整やスイッチハードウェアをインストール、設定してください。

このガイドのこれ以降のセクションは、DAQまたは PXI信号調節実装デ
バイスのみ関する内容です。
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手順 9. センサと信号線を取り付ける
センサと信号線をターミナルブロックまたはアクセサリ端子に取り付け 

ます。 

DAQアシスタントを介して、システム中の NI-DAQmxタスクおよび仮
想チャンネルの接続ダイアグラムを表示して印刷できます。 タスクまたは
仮想チャンネルを選択して、接続ダイアグラムタブをクリックします。 セ
ンサからコネクタブロックへの接続の端子の名前と数を表示するには、タ

スク中の各仮想チャンネルを選択します。 

ピンの割り当ては、Device Document Browserから参照できる各デバ
イス文書、または『NI-DAQmx対応Measurement & Automation 
Explorerヘルプ』の「デバイス端子」に記載されています。Device 
Document Browserには、スタート→プログラム→ National 
Instruments→ NI-DAQ→ Browse Device Documentation（インス
トール済みの場合）を選択してアクセスできます。

センサに関する情報は、ni.com/sensorsまたは『NI-DAQmxヘルプ』
（スタート→プログラム→ National Instruments→ NI-DAQ→
NI-DAQmx ヘルプを選択）の「センサ」の項目で参照できます。 
IEEE 1451.4 TEDSスマートセンサの情報については、ni.com/zoneを参

照してください。 

スイッチの仕様にはデバイスのトポロジーが含まれています。

手順 10. テストパネルを実行する
多くのデバイスには、信号の集録や生成などの特定のデバイス機能をテス

トするためのテストパネルがあります。 

1. MAXで、デバイスとインタフェース→ NI-DAQmxデバイスを展開
します。 リモート RTターゲットを使用している場合、リモートシス
テムを選択し、ターゲットを検索して展開し、デバイスとインタ

フェースを展開します。

2. テストするには、デバイスを右クリックします。 

3. 選択されたデバイスのテストパネルを開くには、以下の例に示すよう

にテストパネルを選択します。
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4. デバイスのさまざまな機能をテストするには、タブをクリックしま

す。 テストパネルの操作方法は、ヘルプをクリックして参照できます。

5. テストパネルには、エラーが発生したかどうかを示すメッセージが表

示されます。 その場合、トラブルシューティングについては、
『NI-DAQmxヘルプ』または ni.com/support/jaを参照してくだ

さい。 

6. テストパネルを終了するには、閉じるをクリックします。

複数の DAQデバイスをインストールする場合、各デバイスごとに手順
「手順 7. デバイスを設定する」～「手順 10. テストパネルを実行する」を
繰り返します。 

手順 11. チャンネルとタスクを構成する
この手順は、NI-DAQmxまたは NIアプリケーションソフトウェアを使用
してデバイスをプログラムする場合のみに適用されます。 

NI-DAQmxの重要な概念であるタスクとは、タイミング、トリガ、その
他のプロパティを備えた単一または複数の仮想チャンネルを指します。 タ
スクは、実行するべき計測または生成を表します。 タスクで構成情報を設
定、保存し、それをアプリケーションで使用することができます。

NI-DAQmxでは、仮想チャンネルをタスクの一部として、またはタスク
から切り離して構成できます。 タスク内に作成した仮想チャンネルは、
ローカル仮想チャンネルと呼ばれます。 タスク外に定義した仮想チャンネ
ルは、グローバル仮想チャンネルと呼ばれます。 グローバル仮想チャンネ
ルはMAX内あるいはアプリケーションソフトウェア内で作成して、
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MAXに保存することができます。また、どのアプリケーションでもグ
ローバル仮想チャンネルを使用することができるだけでなく、さまざまな

タスクにそれらを追加することもできます。 グローバル仮想チャンネルを
変更した場合は、その変更がそのグローバル仮想チャンネルに関連するす

べてのタスクに影響を及ぼします。 

NI-DAQmxでタスクを構成する
NI-DAQmxを使用する場合、DAQアシスタントでタスクを構成します。 
DAQアシスタントでタスクおよび仮想チャンネルを作成するには、NIア
プリケーションソフトウェアパッケージの 7.0以上のバージョンを使用す
る必要があります。

� MAXでデータ設定を右クリックして、新規作成を選択します。 新規
作成ウィンドウで NI-DAQmxタスクを選択して、次へをクリックし
ます。 リモートで RTターゲットを使用している場合、まずリモート
システムを展開し、ターゲットを検索して展開してデータ設定を表示

する必要があります。

� また、NIアプリケーションソフトウェアの中から直接 DAQアシス
タントを開くこともできます。

� LabVIEWで、『LabVIEW入門』の説明に従って、Express入力
パレットから「DAQアシスタント」Express VIをブロックダイ
アグラムに配置します。

または、DAQmx名前制御器パレットで DAQmxタスク名を右
クリックし、新規タスク（DAQアシスタント）を選択して
DAQアシスタントを開くこともできます。 『LabVIEWにおけ
る NI-DAQmx計測』チュートリアルには、DAQmxタスク名制
御器でタスクを作成する方法およびタスクに基づいたコードを生

成する方法が段階的に説明してあります。 LabVIEWでヘルプ→
LabVIEWにおける NI-DAQmx計測を選択します。

� LabWindows/CVIの場合 :

1. Tools→ Create/Edit DAQmx Tasksを選択します。 
Create/Edit DAQmx Tasksダイアログボックスが開きます。 

2. Create New Task in MAXまたは Create New Task in 
Projectを選択し、OKをクリックします。

� Measurement Studioの場合 :

1. Visual Studio .NETを開き、DAQmxタスクのクラスを作成
するプロジェクトを開きます。

2. Project→ Add New Itemを選択します。 Add New Item
ダイアログボックスが開きます。 

3. Categoriesぺーンで、Measurement Studio→
Assistantsを選択します。
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4. Templatesぺーンで DAQmx Task Classを選択します。
5. DAQmxタスクファイルの名前を指定して、Openをク
リックします。 

6. 新規タスクまたはMAXで作成したグローバルタスクのプロ
ジェクトコピーを作成するかどうかを指定し、Finishをク
リックします。

DAQアシスタントで、I/Oタイプ（アナログ入力、実行する測定や生
成、測定に使用できるセンサ、ローカル仮想チャンネルを作成する基とな

る物理チャンネルなど）を選択して新しいタスクを作成する画面が表示さ

れます。 グローバル仮想チャンネルがすでに構成されている場合は、仮想
タブをクリックしてグローバル仮想チャンネルをタスクにコピーまたは追

加します。 タスクの作成方法については、『DAQアシスタントヘルプ』を
参照してください。

NI-DAQmxのグローバル仮想チャンネルを構成する
複数の NI-DAQmxタスクまたはアプリケーションで仮想チャンネルを使
用する場合は、DAQアシスタントでグローバル仮想チャンネルを構成し
ます。 DAQアシスタントを起動し、MAXまたは LabVIEWでグローバル
仮想チャンネルを作成することもできます。

� MAXで DAQアシスタントを開くには、データ設定を右クリックし
て、新規作成を選択します。 新規作成ウィンドウで NI-DAQmxグ
ローバル仮想チャンネルを選択して、次へをクリックします。 

� LabVIEWで直接 DAQアシスタントを開いてグローバル仮想チャン
ネルを作成するには、DAQmxグローバルチャンネル制御器をフロ
ントパネルにドロップし、この制御器を右クリックして、新規

DAQmxチャンネルを選択します。

DAQアシスタントで、I/Oタイプ（アナログ入力、実行する測定や生
成、測定に使用できるセンサ、グローバル仮想チャンネルを作成する基と

なる物理チャンネルなど）を選択して新しいグローバル仮想チャンネルを

作成する画面が表示されます。 タスクおよび仮想チャンネルを作成して、
それらをアプリケーションで使用する詳細については、『DAQアシスタ
ントヘルプ』を参照してください。

LabWindows/CVIまたはMeasurement Studioではグローバル仮想
チャンネルを直接作成することができないので、前述のようにMAXでグ
ローバル仮想チャンネルを作成する必要があります。

アプリケーションソフトウェアからグローバル仮想チャンネルをタスクに

追加またはコピーできます。

1. 「NI-DAQmxでタスクを構成する」で説明されているように、DAQ
アシスタントを起動します。 

2. チャンネルを追加ボタン（ ）をクリックします。 

3. チャンネルをタスクに追加ダイアログボックスで、仮想タブからコ

ピーまたは追加するグローバル仮想チャンネルを選択します。
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手順 12. アプリケーションでデバイスを使用する

DAQ アシスタント
使用しているアプリケーションで計測タスクを使用したり、コードを生成

するには、以下の手順に従ってください。 詳細については、『DAQアシス
タントヘルプ』 を参照してください。

LabVIEW
1. LabVIEWでブランク VIを開きます。 

2. ブロックダイアグラムで、 NI Measurement→ 

DAQmx-データ集録→ DAQmxタスク名定数を選択して定数を配置
します。

3. タスクをプルダウンメニューから選択します。 

4. VIを右クリックしてコードを生成→サンプルを選択します。 

5. フロントパネルからプログラムを実行します。

LabWindows/CVI
LabWindows/CVIでタスクを使用する方法については、ni.com/info

で rddq73と入力して表示される情報（英語）を参照してください。

Measurement Studio
Measurement Studioでタスクを使用する手順については、
ni.com/infoで rddqmsと入力して表示される情報（英語）を参照して

ください。

サンプル
サンプルを使用して、新しいアプリケーションを開発したり、サンプルの

コードを既存のアプリケーションに加えたりすることができます。

ソフトウェアアプリケーション サンプルの場所

LabVIEWまたは LabWindows/CVI ヘルプ→サンプルを検索

Measurement Studioでサポートされる言語
MFC C++ 

Visual Basic .NET およびC#のサンプル *

MeasurementStudioVS2003¥VCNET¥ 
Examples¥DAQmx

MeasurementStudioVS2003¥DotNET¥ 
Examples¥DAQmx

ANSI C NI-DAQ¥Examples¥DAQmx ANSI C

*Measurement Studioは必須ではありません
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その他のサンプルについては、ni.com/zone（英語）を参照してくださ

い。

ハードウェアをインストールせずにサンプルを実行するには、

NI-DAQmxシミュレーションデバイスを使用できます。 シミュレーショ
ンデバイスの作成手順については、MAXでヘルプ→ヘルプトピック→
NI-DAQmxを選択して、『NI-DAQmx対応Measurement & 
Automation Explorerヘルプ』を参照してください。 

VI Logger Lite
NI-DAQmxの CDには、データロギングアプリケーション専用の使いや
すい構成ベースツールである VI Logger Liteが添付されています。 この
ツールは、スタート→プログラム→ National Instruments→ VI Logger
を選択して起動できます。 『VI Logger Help』を参照するには、MAXで
ヘルプ→ヘルプトピック→ VI Logger Helpを選択します。

その他の情報

デバイス文書をインストールすると、ブラウザおよび文書をスタート→ 

プログラム→ National Instruments→ NI-DAQ→ Browse Device 
Documentationから表示できるようになります。 NI-DAQソフトウェア
文書（『NI-DAQmxヘルプ』や『DAQスタートアップガイド』など）
は、スタート→プログラム→ National Instruments→ NI-DAQ→
NI-DAQmx文書タイトル  を選択して参照できます。

トラブルシューティング

DAQハードウェアおよび /またはソフトウェアのインストールで問題が
ある場合、以下のリソースを参照してください。

� トラブルシューティングの説明については、ni.com/support/ja/ 
troubleshootingのトラブルシューティングリソースを参照してく

ださい。

� 一般的なインストールやプログラミングに関する問題点のトラブル

シューティングおよび NIの製品についてよくある質問（FAQ)の回
答に関する文書については、ni.com/jp/kbを参照してください。

� デバイスが損傷した可能性があり、ナショナルインスツルメンツの

ハードウェアを修理またはデバイスキャリブレーションのために返送

する必要がある場合は、日本ナショナルインスツルメンツの技術サ

ポートへご連絡ください。電話番号：03-5472-2981　 

（平日　9：00-12：00　13：00-17：00）
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世界各国の技術サポート

その他のサポートについては、ni.com/support/jaまたは ni.com/zone

（英語）を参照してください。 信号調整に関する製品のサポートについての
詳細な情報は、ご使用のデバイスに添付されている『Signal 
Conditioning Technical Support Information』をご覧ください。

ナショナルインスツルメンツでは、米国本社（11500 North Mopac 
Expressway, Austin, Texas, 78759-3504）および各国の現地オフィスに
てお客様にサポート対応しています。



 

National Instruments、NI、ni.com、および LabVIEWは National Instruments Corporation 
（米国ナショナルインスツルメンツ社）の商標です。National Instrumentsの商標の詳細については、 
ni.com/legalの「Term of Use」セクションを参照してください。本文書中に記載されたその他の 
製品名および企業名は、それぞれの企業の商標または商号です。National Instrumentsの製品を保護 
する特許については、ソフトウェアに含まれている特許情報（ヘルプ→特許情報）、CDに含まれている 
patents.txtファイル、または ni.com/patentsのうち、該当するリソースから参照してください。
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